Netopia, Broadband Without Boundaries™ nEtuD|a.ﬁ.

GETTING STARTED WITH
TIMBUKTU PRO® FOR WINDOWS
VERSION 8.6



Copyright notice
Copyright © 1999-2006 Netopia, Inc. v.102006
All rights reserved. Printed in the U.S.A.

Netopia, the Netopia logo, and Timbuktu are registered trademarks belonging to Netopia, Inc., regis-
tered U.S. Patent and Trademark Office. Broadband Without Boundaries is a trademark belonging to
Netopia, Inc. This manual and any associated artwork, software, product designs or design concepts
are copyrighted with all rights reserved. Under the copyright laws this manual or designs may not be
copied, in whole or part, without the written consent of Netopia. Under the law, copying includes trans-
lation to another language or format.

Timbuktu Pro 8.6 works with Skype software. This product uses the Skype API but is not endorsed or
certified by Skype. Skype is a trademark of Skype Technologies S.A. in Luxembourg and other
countries.

Netopia, Inc.

Marketplace Tower

6001 Shellmound Street, 4th Floor
Emeryville, CA 94608

USA

Part Number
This manual is Netopia part number 6161105-PF-06.



CONTENTS

Chapter 1: Introducing TIMDUKLU Pro ......eeeeeieeiiiiiiirieeneeeeeeieccrnnrnnneeeeeesescesssssnnsesssssssssssssnnsensaseses 6
TIMDUKEU PrO SEIVICES eveiiieiiiieeiieeitte e ceeeitteeeeeseteeee s e e sevaeeeessesessaeaesssesnseneessessssnneessenssens 6
Connecting With TIMBDUKLU PrO....cceeei ittt eeeeee e e e erearerereeeeseeeeseseneas 7

TIMDUKEU PrO TraNSPOrtS...uueeeeeeciirreeeeeeiiiereeeeseitreeessessssneeessessnsnnessessssssseessesssssresessesssnns 7
Who Can Connect to Your Timbuktu Pro COMPULEI? ......uuiieeeeiieiiiieeeeececinreeeseeeirneeeseeeenns 8
What Timbuktu Pro Can D0 fOr YOU ceeeeeuueeieiiieriiieeeeerieeeeeeserreeeesseierreeessssneneeessssnnseneesssnnns 8
TIMDUKEU PrO FEATUIES weveeiieeeiiiiieeieiiitetee sttt eeeserireeeesesesreeeessssssseaeesssssssseasssssssssnsasssssnnns 9
New in TIMbUKLU Pro VErSion 8.6 .......uiiiririiieeieeieeeeereeeeseeeeeeeeeenneseseersseseeeeeeeeseeeens 9
New in TIMbUKLU Pro VErSion 8 ........eieirieeeeeee e e e s e e e nenereereeeeeeeeeeeeseeee s 9
TiMBDUKLU PrO SBIVICES coieiieie i ceeeeectetetetrrre e e e e e e e e e e e e e e e e s e nnnsssssseanaeseeeeeeeeeaesenenas 11
Other TIMBUKLU Pro FEAtUIES ...uueveeieiieeeieieeeee e e e e e ceceeeeccccereereeeeeseeeeeeeeeeeee e e s e s nnnnnnns 12
System Requirements for TIMBUKEU PrO.....uvuveiiiiiiieecccceee et evre e s eeevee e e s se e 16
Minimum Hardware REQUITEMENTS.....uuiiieiieeciiteeeeereitrree e seerere e e s errraeeessearreeeessnnnenns 16
Minimum Software REGUITEMENTS......cciiiieeiiireeeeercereeeeeserreee e e e serrreeessesreraeeesseseseneeas 16

Chapter 2: Installing Timbuktu Pro for Windows .........eeeeeeieeeceirenrrneeeeeeicsicsssnnnneeeseessscssssssnnnnsaens 17
Before Installing Timbuktu Pro for WindOWS .......eeeeeeieeeeieeeeeerreeteeeeeeeeeeeeeeeeeee e ennnnnens 17
Installing Timbuktu Pro for WiNAOWS ........eeieieeeeieeieeeieeeeeccccccerrreeeeeeee e e e e ee e e e e s enes 18
Removing Timbuktu Pro from YOUr COMPULET .....ciiiereeiueieeeierrirteeeeeeeiieeeeeseeereeeesssssneeeee e 20

Chapter 3: Setting Up TIMDUKLU PTO ..cccccueeiiiiereeerecreeeeiecrneeescsseneesssssnesssessanesssssaneesssssanessssssanens 21
TimbUKEu Pro STartup OPHiONS ...ceeecueeeeeiieereieereiteeneee et ree et e s eee e s esree e s ee e e s meee s e 21

Starting TiImbuktu Pro Manually.........eeeeeeeeeeeeeeeeieeeeeccccccccrrnrrrrreeeeee e e e e ee e e e e eee e enes 21
Exiting and Shutting Down TiMBUKLU Pro....eeeeeeeeee et eeeeee e e ee e e e 22
Exiting Timbuktu Pro from the File MENU .......eeeeerereeeieeeeeeeeeeeeeeeeeeeeeerennneeereeeeeeeeeeeeens 22
Customizing Your TimbuKtU Pro Prefe@renCeS ......uuveeeeeeeeeriieieeeeeeeeeeeeeceeeecenrrreeeeeeeeeeeeeeeeens 23
GENEIAL PIrEIEIENCES «..eeeetiiiiiertitteeeeee e eeeeeeeeeeeeeeeeeeeee e ssssssssarsseessseeeseseeseseseesenensensnnnes 24
Observe/Control HOSt Pref@rENCES ..uuuuviviiiiiiieeieeeeeee ettt e e ee et e e e e e e s essssssnannes 26
Observe/Control GUESTE PreferenCeS ....uuuiiiiiiii ittt ee e e e e e e e et eeeessssesssssssnnnes 31



Getting Started with Timbuktu Pro for Windows [iv

SENA PrEIEIENCES ..oeeeeeeeeeeitettteeeeree e e e et et et eeeeeeseeeeesennsssssssarssrearsaeeseseeeeeeeesesennnnnes 35

N T A o €= (=T (=] o[ 37
Setting Up YOUr Master PASSWOIM ........eveerireeeriierirreiiieeeeeeenireeeeesseneeeeessssssseesesssssnseneens 38
Setting SKYPE Pref@rENCES ....uneeeeeeeeeeteeeeee et rrerrrrreeeeeeee e e e e e e e e s e e eeeeenannes 39
Setting Dial DireCt PreferenCes ..ouii v eiieiiiieeiiiitee ettt e seerreee s s ssasseeee e s s ssnsneaes 40
LOZEING PreferBNCES coviiieeeiieeeeieeeeiitteeeeeeiite e e e s erree e e e st e e e e sesareeeeessssnsraaaesssssnsnneens 42
SEttiNG LDAP OPLiONS .uuviiiiiiitiieiieiitiiitieieeeeseseriierrrreeeesteeeeseeseseesssesssssssssssssssssssssseesesaesesens 44
Controlling AcCeSS t0 YOUI COMPULET ..vieiiieeiiiieeeeeecrreeeeeeertreeeeeeserreeesesssveneesssssssssnnessennes 46
Chapter 4: Making a Timbuktu Pro CoNNECtion .......ccccceeeeeieicerrenrrnneeeeeecescssssnnneeeeesesscssssnnseneaees 47
The Main TImMbUktu Pro WiNAOW .....cccccuiiieeieiceiiieeeeeceiire e seeiire e e s e snvaeeesserevveeeessennnnvesessns 47
IV BNUS ettt e e e ee ettt eese e e s e eee et re e e s s asseesessessaeaseesessnssssssssssseseeeesenensennssnssnnns 48
SEIVICE BULTONS cevtteiiieiiteeee ettt eete e e e s st e e e s s are e e e s s ssnnaeeesssssnseaassnsnnns 48

(Qo Y g g LYot o1 T - U o 1R 48

) 2= (130 2 -1 G PP PPPPPPRRPIN 48
The Timbuktu Pro CONNECtION PrOCESS ...ciiiiereiieierieeeiieeteeeeerrieeeeessssireeeeessenrreeeessssnnsseeeesses 49
Selecting @ REMOtE COMPULET..ciiiiieeirreeieeritrteereeeetreeeeeeesrreeeeessesnereeeesssssseneaesssssnsenas 49
ChOOSING @ SEIVICE eiiiiiiiieeetieiiiteee ettt e e ettt e e s eatte e e s s ssasrreeessssssaeesssssnssnaeesssssnsnns 49
Re-Establishing an Earlier CONNECtioN....cooeeeeeeceeciiiieeeeeeeeeeeeeeeeeeeeeeeeceereaeerereeeeeeeeees 50
Using a Timbuktu Pro Connection DOCUMENT ..ceeeeeeenerririieeeereeeeeeeeeeeeeeeeeeeeeeeeeeeenennnns 50
MaKing @ NeW CONMECTION ueiiiiiieiiiiieeeieeeeeirirterereeeeeeeeeeeeeeeeeeeeeeeeesnnnsssssssereraeerssseeeeseeeseenns 51
USING the TCP/IP TAD weveeee ittt ettt eeeavee e e e e eeesaeeeeesenssssseeesensannneas 51
Using the Skype Contacts Tab to Find a Remote COMPULET ....uvveeieecirieeeeieeicrreeeeeeeceeeen. 54
Using the LDAP Server to Find @ Remote COMPULET.....ceiiieccireeeeieciiereeeeeecireeeeeeeceveeeeens 57
Scanning the Network for Timbuktu Pro COMpPULErsS......ccoeveirrercerecreeeeeeeeeeeeeeeeee e 58
Re-Establishing a Previous CONNECLION.......uueeiireeeeieeeeeeeeee e eeeceeeccecrnnnrerrrreeeeeeeeeeeeseseseneennns 59
Using the Recent ConNections Tab co...eiveiiiieeiiiiiiiieieteeeccereeee et e s 60
Using the Address BOOKS Tab ..eeeeeeeeeeiiiii et eaneeneees 61
Making a Dial Direct CONNECHION .....ueiiiiieiiiiieeiereiteeeeeeeieete e seerree e e s s rrreee s s s snneeeessssnnneeens 66
Timbuktu Pro ConNection DOCUMENES...cvuvuuereieeeieeeeeeeeeieieirireeeeeeeeeeerereeesssanneeeeeeeseesssssssnnes 67
Chapter 5: The TIMbUKLU Pro SEIVICES ....eeeeiiiiiiiiiirrrneereeeiieccennrsrsnneeeeessesssssssnnnssssssssssssssssnnsnsases 70
Send: Sending FlashNotes and Files to Remote COMPULETS......cceeeevieeeeiieiiieeeeeeecieeeeeeeeanes 70
Exchange: Copying and Moving Files Between COMPULETS ...cccuvveeeericiiireeeieiiieeeeeeciinnee e 72
Remote Control: Controlling or Observing a Remote COMPULET......ceiieeciireeeeeeeiirreeececieeeeenns 74
The Screen-Sharing SYStEM MENU....cccccuvieeeiieeiirieeeiecrireeeseesereeeeseeseveeessesssnsneesssesnnes 76
The Host Settings Dialog BOX..ccuuueieiieeiiiieeeireiitieeeeeeiteeeesesreeeessessneeeesseneeaeesssnnes 76
Using the Capture FTame ....coocvieieieieeeteeete et et s et e st e s e e s emseee s sneeesemnees 78
Sending CTRL+ALT+DEL to @ Remote COMPULET ..ceveeeviieeeiieeiiiteeeeeeereeeeeeneereeeeeseseeneeees 79

Controlling @ MacintoSh COMPULET ...ciieuuiiiiiiieeiiteeeieeeeeee et eesesrreeeeeseeeeeesesannee 79



Getting Started with Timbuktu Pro for Windows |v

Notify: Requesting Notification When the Remote User is ACtiVE ....coeuvveeeiieecivieeen e, 80
Chat: Chatting With @ REMOLE USEI ...uuiiiiiiieiiiieiieeteteeeertteeeeeesreeeeesesreeeessssraeaeesssanns 82
Intercom: Speaking to @ REMOTE USEr.......uiiiiiiiiireiieenteeetee ettt e s emee e 83
Invite: Inviting a Remote User to ACCeSS YOUr COMPULET ..cceirreuuereeereriirreeeeeniereeeeenenereeeeannns 84
Skype: Using Skype with @ Remote COMPULET....ivcuerieerrieiiiieeeeeeireeeeeereeeeeseineeeeesesanee 86
Chapter 6: SECUITY ciivveeirrrrennnrreiiieiieenisrsnneeteessessssssnnansessssssssssssssnnssssssssssssssssansssssssssssssssensansans 87
TiIMDUKLU PTO REMOLE USEIS c.uurervrieriiieeeeeeeeeeeeeeeeeeeeeeennnntrsesreeeseessseseeeeeseesesnesssssssssssssssssssees 87
The SeCUTitY DI@loZ BOX vuvieiieecirreeieieiiiiieeiesecirteeeseseiteneeesesersreesssessssseessssssssssessssssssssessssns 88
Managing TIMDUKEU PrO USEIS...ccciieieieeeeeeienrnreereeeeeeeeeeeeeeeeeeeeeseeeseesnsssssssssssessssssesesseseses 89
ASSIGNING SErvViCes t0 GUEST USEIS ..uuieiiiiieeeieeitiiceeeeeeeeeeeeeeeeeteeeeeeeeeeeeeesssssssnnnnneeens 89
DefiNiNg REGISTEIEA USEIS.cuuiiiiiiiiieiiieieieeeeeeeeninrrrrrrreeeereeeeeeeeeeeeeeeeeseesensssssssssssresssaesesees 91
Defining WindOWS NT USEIS ceceiiiiiieeeceececcceteierrrrrreeeeeee e e e e eeee e e s esnnnenseseeeseeeeeeeens 94
AEENAEA ACCESS eeeeeieeeeieececeeeccccecrerrrereeereeeeeeeeeeeeeeeeseeee s nssssnnsssssrarasaaeaaeeeseeeeeeesennanans 98
ASK fOr PEIMISSION ACCESS weeruureiereieieeiieteeireeeeieee sttt esreeeesreeeesneeeseneeessneeeessneeeesnnenes 99
TEMPOTArY GUESE ACCESS ceiiiieieeeeeeriiiiierereeeeeeeeeeeeereeesesssssssnsnnnnnnerrnererereeseseessessssnans 100
Monitoring RemMote CONNECTIONS ciiieiieeeceeceeeerrereee e e e e e e e e e e e ee e e e e nnennnreeearareraeaeseeeeees 102
DisconNNeCting ALl REMOLE USEIS ....uuueeeeiirerereiririeeeeeeeeeeeeeeee e e rensnrerseseeeeseeeseeenaeens 102
Disconnecting a Specific REMOLE USEI . ...uuiiiiiieeiiiieeiececireeeeeeeereeeeeesvrree e s e sevveneeeeenns 102
Keeping REMOTE USErS QUL .ccciiiiiiiiiiiiieieiiiiiiiieeeeeeeeeeeeeeeeeesesesssssasassnsssseseseseeseeessases 102
Clearing the PrevioUs USEr LiSt.. .. eeeerereereeeeeeeeeeeeeeeeeeeeeeeeennnnnssssseeseseeseeseeeeeseeeessnenns 103
USING LOZ FILES 1ennneeeeiireiieiteieeeeeeeeeeeee et eeeeeeeeeeessannsesesseseseseesssseeeeeeesessssssssssssnsssssnsnnnns 103
TIMBDUKLU PTO LOZING oeeeeeeeitiiiietrttteeeeeeeeeeeeeeeeeeeeeeeeeeeeennnsssssssessseesesaeseseseeesensesesnsenesnnnnes 103
THE ACHIVITY LOZ cuurvrrreeiieiciiiieeesieeeiteeeeesesstaree e e eestraneesesensrsaeesssesnsssaessssssssnsesssssnssneeees 104
The EVENT LOG FIlB.eiiiiieiiieeeeieiiieee ettt e e e st e e e e s s ae e e e s s s e eeeessssseaaeeasnnen 106

The Windows Application EVENT LOG....ccevveteeeiueereiiieneeeeneeeeeeeeeeneee e e eeee e 106
USING @ MaASTEr PASSWOIA .eeeiieeieeieeieiececeecieteeerereeeeeeeee e e e ee e e e s s nnnsnnssssaeeeseeeseeesesessnnnns 106
Chapter 7: Timbuktu Pro USer ASSIStANCE .....ccccceeeeeeruerereesrreeecesssneesesssneesssssnnnessssnnsessssnnesssssns 107
Getting Help in TIMDBUKLU PrO cooiieeeeieiieieeieee ettt ettt serreee s s eiienee e s s snneee e s sssnnnnes 107
Opening Timbuktu Pro’s Onling HElP ..ueeeeieeeciiieeeeeeeciiiee et ceceree e e eevvvaee e s s eeaenne 107
CONTACTING NELOPIA uuvueriiriiririieeeirteeteeeteteieereeessessrrerrereeeeeeeeeeeeseseesssessssssssssssssssesnssssaeaees 108
Outside of the United States and Canada .....ccccuveeeeiieiiieeeeeieciireeecescree e e e eeeireeeeeeeaes 109
APPENDIX A: KEYBOARD SHORTCUTS AND SERVICE ICONS ...coirrieeeneneeennccereneeeeennnnnnssnssssannens 110
Timbuktu Pro Keyboard ShOMCULS .......eveierieiiiiieiieeeitieeceercieeeees s esrreeee s sseneeee e e s seneeneeeseen 110

1o g T =Y =Y o o PP 111



CHAPTER 1: INTRODUCING TIMBUKTU PRO

Welcome to Timbuktu Pro for Windows™!

Timbuktu Pro for Windows gives you total access to your network. Computers
across the country and around the world—Windows and Macintosh—are now as
accessible to you as the computer sitting on your desk! You can use Timbuktu Pro
to control and observe other computers, send instant messages, transfer files,
and text-chat or speak with remote users in real time. And when you’re not on a
network, Timbuktu Pro for Windows lets you make direct modem-to-modem con-
nections between computers—with no network connection required.

TIMBUKTU PRO SERVICES

The simple, powerful Timbuktu Pro application includes multiple services. Each
service provides you with a different way to access a remote computer, collabo-
rate with its user, or provide access to your own PC.

Timbuktu Pro’s services include

e Send. Send messages with attached files and folders to a remote computer.
e Exchange. Access the hard drive of a remote Timbuktu Pro computer—even a
Macintosh. You can copy and move files and folders between computers and
delete files from either computer.

Control. Control a remote computer from your own desktop.

Observe. Observe a remote computer without controlling it.

Notify. Be alerted when a remote Timbuktu Pro computer becomes active.
Chat. Carry on a keyboard conversation with a remote user.

Intercom. Speak to a remote user through your computer’s audio hardware.
Invite. Ask other users to visit your computer using a service you specify.
Skype. Access the Skype internet-telephony application to speak or text-chat
with a remote user. The Skype service includes two subservices: Skype Call
and Skype Chat.

/6
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CONNECTING WITH TIMBUKTU PRO

When you’re at the office, Timbuktu Pro runs over your organization’s local net-
work for easy conferencing and information sharing. When you’re home or travel-
ing, you can log on to a remote access server and use Timbuktu Pro to take direct
control of your office computer. You can even use your modem to dial directly into
the modem of another computer, with no network connection required.

Once you connect to a remote computer with Timbuktu Pro, you can run software
atits normal speed, dramatically decreasing over-the-phone delay of applications
such as relational databases and electronic mail. Timbuktu Pro gives you full ac-
cess to remote resources, but transfers only screen, keyboard, and mouse infor-

mation—you don’t have to move large amounts of data over slow telephone links.

TIMBUKTU PRO TRANSPORTS

Timbuktu Pro communicates with other Timbuktu Pro computers over TCP/IP net-
works (LAN, WAN, DSL, cable, and ISDN) and over direct modem-to-modem con-
nections. If you are connected to the Internet or can make a modem connection,
you can use TCP/IP and Timbuktu Pro services to collaborate with other Timbuktu
Pro users around the world.

THE TCP/IP TRANSPORT

Most of your Timbuktu Pro connections will use the TCP/IP transport, which uses
the same protocol as any basic Internet or intranet connection.

THE SKYPE TRANSPORT

The Skype transport provides an additional connection pathway for Timbuktu Pro
services. Skype is an Internet-telephony application available for free download
at www.skype.com. Skype uses a proprietary connection protocol that can cross
many firewall and NAT-router configurations without requiring any special config-
uration. When integrated with the Skype application, Timbuktu Pro can “piggy-
back” on the Skype data stream to establish a Timbuktu Pro connection.

The Skype transport makes it possible to make Timbuktu Pro connections to com-
puters behind NAT routers or firewalls, or otherwise inaccessible to previous ver-

sions of Timbuktu Pro without special configuration. You can open a Timbuktu Pro
connection to any computer to which you can open a Skype connection.
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THE DIAL DIRECT TRANSPORT

Timbuktu Pro also includes a direct modem-to-modem protocol called Dial Direct.
You can use Dial Direct to connect directly to a remote Timbuktu Pro computer
with no other network connection required.

WHO CAN CONNECT TO YOUR TIMBUKTU PRO COMPUTER?

The first and most important answer is “No one—without your permission!” But
once you have set up your security options, anyone who meets your connection
criteria may connect.

If your computer is connected to a company network that is protected by a fire-
wall, your Timbuktu Pro computer may only be accessible to users from your local
network. However, firewalls can be configured to admit Timbuktu Pro traffic.

WHAT TiMBUKTU PRO CAN DO FOR YOU

With Timbuktu Pro, you can

e Save technical support time and money by taking control of a remote user’s
computer and solving their problem without leaving your desk.

e Train employees and customers alike for a fraction of the usual time and cost.
Demonstrate the latest applications or products while a remote user watches.
Then observe and help as the user practices. Provide individual attention for
all remote trainees, and save the time and expense of travel.

e  Work remotely from wherever you are. Harness the power of remote control to
share information, transfer files access databases, and send messages
across your network. You’ll discover many ways to work easier and smarter.

e (Collaborate with remote colleagues in real time. Share screens, documents,
and information with both Windows and Macintosh computers. Work with
others anywhere, and confer with your colleagues using audio- or text-based
conferencing.

e  Run “LAN-locked” network applications such as databases without the frus-
tration of slow run-time over remote links. Applications run on the remote
computer, not across telephone lines, reducing processing time dramatically.

e Protect your network resources. You can open and close transports and grant
custom combinations of Timbuktu Pro services to individual Registered User
and Windows NT User accounts.
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TIMBUKTU PRO FEATURES

Timbuktu Pro’s rich feature set lets you work with remote computers—and remote
users—more efficiently and securely than ever before. Remote control capability;
Dial Direct, LDAP, Internet Locator, and TCP/IP Scanner features; enhanced secu-
rity: Timbuktu Pro is packed with features to make your network work for you.

NEw IN TIMBUKTU PRO VERSION 8.6

Timbuktu Pro now features the Skype integration to provide new services and en-
hance your connection possibilities.

SKYPE INTEGRATION

The new Skype integration provides you with both the Skype transport and the
Skype service.

e The Skype transport provides a connection pathway for Timbuktu Pro ser-
vices that can cross many firewall and NAT-router configurations without any
special configuration.

e The Skype service lets you access the Skype internet-telephony application
to speak or text-chat with a remote user. The Skype service includes two sub-
services: Skype Call and Skype Chat.

NEW IN TIMBUKTU PRO VERSION 8

Timbuktu Pro version 8 takes full advantage of the Internet as well as the most re-
cent improvements and features available in the Windows OS. You will benefit
from the latest file sharing and collaboration service refinements. Timbuktu Pro
version 8 makes use of SSH to provide both enhanced security and improved per-
formance. Plus, Timbuktu Pro version 8 includes a number of new features to
make it easier than ever for you manage your files across the network and collab-
orate with remote users.

STREAM ENCRYPTION AND COMPRESSION

Timbuktu Pro version 8 supports SSH to encrypt and compress Timbuktu Pro con-
nections. When you begin a remote connection, you will have the option to select
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SSH encryption and enter the credentials that allow you to securely access the re-
mote computer.

In addition to providing secure connections, SSH compression may increase Tim-
buktu Pro performance.

ENHANCED SCREEN-SHARING PREFERENCES

In Timbuktu Pro version 8, the Observe/Control tab in the Preferences window has
been separated into two tabs: Observe/Control Host and Observe/Control Guest.

The two new tabs provide a number of new options, each of which may increase
the performance or security of your screen-sharing sessions.

In addition, the screen-sharing window’s system menu has been expanded to in-
clude a number of new options. You can control settings for the screen-sharing
window itself, or choose the Host Settings option to open a dialog box with many
of the new guest computer screen-sharing options. With the Host Settings dialog
box, you can change your guest preferences on the fly, during an active screen-
sharing session.

EXTENDED LOGGING
The logging capabilities in Timbuktu Pro have been dramatically enhanced.

Timbuktu Pro now supports two different types of centralized logging for all the
Timbuktu Pro computers on your network:

e The Timbuktu Log Server allows you to copy information from your Timbuktu
Pro activity log or Event Log file to another Timbuktu Pro computer.

e The NT Event Log Server allows you to copy information about Timbuktu Pro
events from your Windows Application Event Log to the Application Event Log
on another Timbuktu Pro computer.

In addition, you may create an Event Log file, a text document which records the
same information that Timbuktu Pro sends to the Windows Application Event Log.
The text format allows you to easily search the log for events you wish to review.

You may also now specify the maximum size for your log files, and you may spec-
ify that certain configuration changes are recorded in the log files.

To set up your logging options, use the Logging tab in the Preferences dialog box.
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SINGLE-STREAM CONNECTIONS

Timbuktu Pro now uses single-stream TCP connections by default. If you are run-
ning Timbuktu Pro through a firewall, you now need to open port 407 only.
Service-specific ports are no longer required unless you are connecting to an
older version of Timbuktu Pro.

MSI INSTALLER

Timbuktu Pro now uses a Windows MSI installer with a user interface, which al-
lows you to set certain options during installation.

TIMBUKTU PRO SERVICES

Each of Timbuktu Pro’s services allow you to interact with remote computers in a
different way; together, they help you make the most of your network. For details
about each Timbuktu Pro service, see Chapter 5, “The Timbuktu Pro Services.”

Every Timbuktu Pro service can work in both directions at once: another user can
send files to you while you are controlling or observing a third computer.

CONTROL AND OBSERVE—REMOTE CONTROL AND SCREEN-SHARING

Control a remote computer anywhere on your network using Timbuktu Pro’s
IntelliScreen™technology. Timbuktu Pro’s Control and Observe services provide a
powerful tool for user support, training, and collaboration. Timbuktu Pro automat-
ically adapts to any video mode.

The AutoScroll™ feature offers automatic panning as you move your pointer on
the remote desktop, ensuring you can always view the entire screen of the remote
computer. Oryou can use the Shrink to Fit option to automatically reduce the re-
mote desktop so that it fits entirely within the screen-sharing window. If you re-
size the screen-sharing window, the view of the remote desktop is also resized.
With the Capture Frame option, only the portion of your desktop that appears in
the Capture Frame is displayed on the remote computer.

In addition to the Capture Frame and Shrink to Fit features, the screen-sharing
window includes several additional features to assist you:

e |t supports a mouse wheel and extra mouse buttons.

¢ You may choose whether keyboard mapping is performed logically or physi-
cally. For example, if the host computer uses a Qwerty keyboard and the
guest computer uses a Dvorak keyboard, logical mapping allows you to press
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the Y key on the guest computer with the same effect as pressing the y key on
the host computer.

e When you control a remote computer, you can choose to force its CAPS LOCK,
NUM LOCK, and SCROLL LOCK states to match your computer’s settings.

SEND—SENDING MESSAGES

Use the Send service to send FlashNotes™—instant text messages that pop up on
the recipient’s desktop. You can attach files and folders to your FlashNotes, trans-
ferring them across your network quickly and easily.

EXCHANGE—FILE TRANSFER

Timbuktu Pro makes transferring files between computers easy. With the Ex-
change service, you can copy, move, and delete files across the network—even on
Macintosh computers—just as if they were on your own computer.

NoOTIFY, CHAT, INTERCOM, AND INVITE

Communicating with other Timbuktu Pro users is more convenient than ever with
Timbuktu Pro’s Notify, Chat, Intercom, and Invite services. Notify alerts you when
a remote computer becomes active. Chat allows you to have a keyboard “conver-
sation” with another user. Intercom lets you have a voice conversation using your
microphone and speakers—no telephone required. And Invite allows you to invite
other users to access your computer using the Timbuktu Pro service you specify.

SKYPE

the Skype service accesses the Skype internet-telephony application to let you
speak or text-chat with a remote user. It includes two subservices: Skype Call and
Skype Chat.

OTHER TIMBUKTU PRO FEATURES

In addition to the enhancements in Timbuktu Pro version 8 and the Timbuktu Pro
services, all your favorite tools and features from previous versions are available.

COMPREHENSIVE MULTI-LEVEL SECURITY

Timbuktu Pro uses a flexible and comprehensive security scheme to allow only
the users you want to access your computer. You can allow access by as few or as
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many remote users as you wish. And you can provide individualized combina-
tions of services and privileges to each different user.

Anyone can access the services you provide to Guest Users. You can define any
number of Registered Users and Windows NT Users, who will have password-pro-
tected access to the specific combination of user access privileges you specify.

If you wish to grant one-time-only access to other Timbuktu Pro services, remote
users can ask for permission to use services you have not assigned. If you choose
OK, they’re connected. If you don’t, they aren’t.

For tightest security, you can even require Registered Users and Windows NT Us-
ers to ask for permission after they’re authenticated. Or prevent remote users
from connecting to your computer entirely.

SHORTCUT MENU

The Timbuktu Pro shortcut menu lets you quickly open Timbuktu Pro and monitor
incoming connections. When a remote user connects to your computer, the Tim-
buktu Pro icon in the system tray on the taskbar alternates with a service icon in-
dicating that a service is in use. For a list of Timbuktu Pro service icons, see “lcon
Legend” on page 111.

CROSS-PLATFORM CONNECTIONS

Timbuktu Pro offers remote control and file transfer between Windows and Macin-
tosh computers. From a PC or a Macintosh, you can remotely control a computer
of either type as if you were seated in front of it. Timbuktu Pro also provides
cross-platform file transfer with a convenient, one-step procedure.

You can even customize your cross-platform file-mapping settings so that Win-
dows file extensions and Macintosh Type/Creator settings are applied automati-
cally when you send files across platforms.

DiAL DIRECT CONNECTIONS

Timbuktu Pro’s Dial Direct feature allows you to use your modem to connect di-
rectly to the modem of another Timbuktu Pro computer. No Internet connection is
required. You can use any of the Timbuktu Pro services with Dial Direct, except In-
tercom and Skype.
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FINDING REMOTE COMPUTERS

Timbuktu Pro includes several different methods for finding remote Timbuktu Pro
computers on your network or on the Internet.

The Internet Locator Server

The Internet Locator feature allows you to connect to other Timbuktu Pro users by
specifying their email addresses instead of their IP addresses. When you enter
an email address on the TCP/IP tab in the main Timbuktu Pro window, Timbuktu
automatically queries Netopia’s Internet Locator server, resolves the correct IP
address, and connects to the remote computer.

LDAP Searches

Timbuktu Pro’s LDAP (Lightweight Directory Access Protocol) support allows you
to easily find and connect to other computers running Timbuktu Pro, without
knowing their IP addresses. Instead of entering a remote user’s IP address, you
can use the LDAP tab to search for other LDAP-enabled Timbuktu Pro users by
their user information. Search strings include computer name, IP address, user
name, email address, location, and comment. You can also store your own infor-
mation to enable other users to find you. User information is stored on Netopia’s
public LDAP server.

Timbuktu Pro Scanner

The Timbuktu Pro Scanner helps you find and connect to remote computers, even
when you don’t know their IP addresses, by browsing your local network for active
Timbuktu Pro computers. You may even connect to the desired computer without
leaving the Timbuktu Pro Scanner.

Skype Contacts

The Skype Contacts tab lists the contacts from your Skype Contacts window. If a
compatible version of Timbuktu Pro is running on the contact’s computer, and the
computer is accepting Skype connections, you can use the Skype Contacts tab to
establish a Timbuktu Pro connection without knowing the computer’s name or IP
address.

Plus, the Skype transport provides flexibility beyond basic TCP/IP connections
and may allow you to connect to computers Timbuktu Pro couldn’t reach before
because of routers or firewalls.
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TIMBUKTU PRO CONNECTION DOCUMENTS

Timbuktu Pro Connection Documents are desktop shortcuts that allow you to acti-
vate a Timbuktu Pro service to a remote computer from a desktop icon. To quickly
create a desktop shortcut, right-click anywhere on your desktop. From the short-
cut menu, choose New » Timbuktu Pro Connection Document.

Once you’ve created a Connection Document, right-click it to display a shortcut
menu. The menu allows you to rename your Connection Document, change its
properties, or delete it.

NETWORK NEIGHBORHOOD /MY NETWORK PLACES

Timbuktu Pro’s Network Neighborhood/My Network Places integration gives you
immediate access to remote computers without opening the main Timbuktu Pro
window. In the Network display, right-click on any computer. From the shortcut
menu, choose Timbuktu Pro » Any Service. You can launch any Timbuktu Pro ser-
vice, as long as the remote computer is running Timbuktu Pro and uses the TCP/IP
protocol.

ADDRESS BOOKS

Use Timbuktu Pro’s address books to help you organize the IP addresses of the
remote computers you connect to frequently. An address book is a collection of
Timbuktu Pro addresses. They save you time because you don’t have to enter an
IP address every time you make a connection. Just select a computer from the list.

RECENT CONNECTIONS

The Recent Connections tab contains a list of computers to which you’ve recently
established connections. The default service (the service that was used during
the previous remote connection) is also saved. Simply double-click an address to
reconnect.

ACTIVITY LOG AND APPLICATION EVENT LOG

Timbuktu Pro keeps a list of all connections made to and from your computer. You
can display the activity log or save it to a text file for printing. Timbuktu Pro also
logs guest and host service events to the Windows Application Event Log.
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SYSTEM REQUIREMENTS FOR TIMBUKTU PRO

To run Timbuktu Pro for Windows, your computer must meet the following hard-
ware, software, and compatibility requirements.

MINIMUM HARDWARE REQUIREMENTS

Timbuktu Pro requires the same minimum hardware that is required by your Win-
dows OS. In addition, you’ll need

e 20 MB of available disk space; 50MB are required for the network installation
process.

e ForTCP/IP and Skype connections, an Internet (TCP/IP) network connection.

e For Dial Direct connections, a 56 Kbps or faster modem.

¢ Forthe Intercom and Skype Call services, a microphone on each computer.

MINIMUM SOFTWARE REQUIREMENTS

e  Windows 2000, Windows XP, or Windows 2003 Server.

e TCP/IP networking software that is installed and properly configured.

e For Dial Direct connections, modem software that is installed and properly
configured. Dial Direct connections use the TCP/IP protocol, so network soft-
ware is still required.

e One copy of Timbuktu Pro software on each computer that is to make or re-
ceive your Timbuktu Pro connections.

COMPATIBILITY

Timbuktu Pro version 8 for is compatible with Timbuktu Pro for Windows 5.0 and
later, and Timbuktu Pro for Macintosh 6.0 and later. Older versions of Timbuktu
Pro are not officially supported with Timbuktu Pro version 8.

SKYPE COMPATIBILITY

The Timbuktu Pro Skype integration requires Skype 1.4 or greater (Skype 2.0 is
recommended). The first time you run Timbuktu Pro, Skype will notify you that an-
other application is attempting to access it. You must allow this action to enable
the Timbuktu Pro Skype integration.



CHAPTER 2: INSTALLING TIMBUKTU PRO FOR
WINDOWS

This chapter will guide you as you install or un-install Timbuktu Pro on a local
computer.

To use the Network Installer or install Timbuktu Pro with Active Directory Group
Policies, see the documentation on the Timbuktu Pro Enterprise Resource Center.
The “Using Timbuktu Pro with Active Directory” document is also available on
your Timbuktu Pro CD.

BEFORE INSTALLING TIMBUKTU PRO FOR WINDOWS

Before you install Timbuktu Pro, please prepare your computer for the
installation.

You must be logged on to the local computer with Administrator or Domain Ad-
ministrator privileges to install Timbuktu Pro.

TO PREPARE YOUR COMPUTER FOR TIMBUKTU PRO INSTALLATION

1. Make sure that TCP/IP software is installed and running on your computer, or
that you have a modem set up and functioning correctly.

2. Uninstall any other remote control software and restart your computer.

3. Disable or shut down any antivirus software installed on your computer.
Active antivirus programs may cause problems during the installation
process.

4. Install Timbuktu Pro.
It is extremely important to uninstall any other remote control software and re-
start your computer before you install Timbuktu Pro. If you install Timbuktu Pro

over other remote control software, or if you do not reboot after uninstalling other
software, Timbuktu Pro may not be completely installed.

[17
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INSTALLING TIMBUKTU PRO FOR WINDOWS

You will install Timbuktu Pro from the CD-ROM supplied in your Timbuktu Pro
package or from the Th2ProWin.exe self-extracting archive file you downloaded
from Netopia’s Web site.

To INSTALL TIMBUKTU PRO

1. Uninstall any other remote control software, restart your computer, and close
all open applications, including antivirus software.

2. Ifyou have a Timbuktu Pro CD, insert it into your CD-ROM drive and open the
CD folder.

If you downloaded the Tb2ProWin.exe file, double-click it. You can specify the
folder where the Timbuktu Pro installation files will be extracted.

3. Double-click the TimbuktuPro.msi file to run the Timbuktu Pro MSI Installer.
The Timbuktu Pro Setup Wizard opens.

ii& Timbuktu Pro - Setup Wizard

Welcome to the Setup Wizard for Timbuktu
timbuktu pro” Pro

The Setup Wizard will install Timbuktu Pro release 8.0 on
your computer, To continue, click Next.

WARNING: This program is protected by copyright law.

| Next > | l Cancel

4. Click Next. The Licence Agreement panel appears.
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5. Inthe License Agreement panel, select the | Accept the Terms in the License
Agreement option. Then click Next. The Destination Folder panel appears.

6. Inthe Destination Folder panel, confirm the Timbuktu Pro installation folder.

By default, Timbuktu Pro is installed in the Program Files » Timbuktu Pro
directory on the same drive where Windows is installed. To change the folder,
click Change. Otherwise, click Next.

The Ready to Install the Program panel appears.
7. Inthe Ready to Install the Program panel, click Install.

8. When Timbuktu Pro installation is complete, you will be notified. Click Finish
to close the Timbuktu Pro Installer.

9. If desired, restart your computer. You can run Timbuktu Pro immediately, but
restarting your computer will improve Timbuktu Pro’s performance.

ALLOWING SKYPE ACCESS

If the Skype application (version 1.4 or later) is installed and running on your com-
puter, the Timbuktu Pro application will attempt to access it automatically when
you run it for the first time. Skype will present a warning dialog box.

.- .-.~§ Another program wants to use Skype
<

*+ WARNING!** A changed program is trying to access Skype!

‘Wwhat would you like bo do?
Mame: thepro.exe
Publisher: Metopia, Inc.
(&) Allaw this program to use Skype
() allaw this program to use Skype, but ask again in the Fukure
() Do not allow this prograrm to use Skype

‘What does this mean?

Note: The exact appearance of this window may vary depending on the Skype ver-
sion and your Timbuktu Pro installation.

Select the Allow this Program to Use Skype option and click OK.
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REMOVING TIMBUKTU PRO FROM YOUR COMPUTER

Should you wish to remove Timbuktu Pro from your computer, it is important to
follow the correct uninstallation procedure.

To REMOVE TIMBUKTU PRO FROM YOUR COMPUTER

1.

Shut down Timbuktu Pro completely. (Click the File menu and choose Exit and
Shut Down Timbuktu Pro.)

From the Windows Start menu, choose Settings » Control Panel » Add or
Remove Programs.

In the list of programs, select Timbuktu Pro and click Remove.
The Add or Remove Programs dialog box appears.

Note: If you uninstall Timbuktu Pro, all files and folders in the Timbuktu Pro
installation folder will be deleted even if they are not part of Timbuktu Pro.
Make sure the folder contains no files that you wish to save.

Click Yes to confirm your intention to remove Timbuktu Pro. All the contents of
the Timbuktu Pro installation folder and its subdirectories are deleted.

When Timbuktu Pro has been uninstalled, a dialog box allows you to choose
to restart your computer immediately or later. You must restart your computer
to complete the uninstall process.



CHAPTER 3: SETTING UP TIMBUKTU PRO

Once you have installed Timbuktu Pro, you can review and change your configura-
tion settings. This chapter describes how to start and exit Timbuktu Pro and how
to set Timbuktu Pro configuration preferences.

TIMBUKTU PRO STARTUP OPTIONS

_

By default, Timbuktu Pro will start automatically when you start Windows. Its icon
is placed in the system tray on the taskbar. To open the main Timbuktu Pro win-
dow, double-click the Timbuktu Pro icon. Or right-click the icon to display the
shortcut menu, and choose Open.

Note: If you are running Windows XP, the full Timbuktu Pro application will not
start automatically. The MiniTB2 application is launched instead. MiniTB2 will
accept incoming Timbuktu Pro connections, but to establish outgoing connec-
tions, you must open the main Timbuktu Pro window by starting the full Timbuktu
Pro application. See the following section, “Starting Timbuktu Pro Manually.”

STARTING TIMBUKTU PRO MANUALLY

If Timbuktu Pro is not launched automatically, or if you shut it down, you can man-
ually start Timbuktu Pro at any time. From the Windows Start menu, choose
Programs » Timbuktu Pro » Timbuktu Pro. The main Timbuktu Pro window opens.

You can configure Timbuktu Pro startup preferences using the General tab in the
Preferences dialog box (see page 24).

[21
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EXITING AND SHUTTING DOWN TIMBUKTU PRO

When you close Timbuktu Pro, you may simply exit the program, or exit and shut
it down. When you exit Timbuktu Pro without shutting it down, Timbuktu Pro con-
tinues to run in the background. Exiting without shutting down gives remote us-
ers the ability to connect to your computer even though you aren’t making any
outgoing connections.

When you exit and shut down Timbuktu Pro, Timbuktu Pro no longer runs in the
background and users can no longer connect to your computer with Timbuktu
Pro.

By default, when you close the main Timbuktu Pro window by clicking the Close
box in the upper-right corner, Timbuktu Pro exits but does not shut down. You
may change this behavior with the Shut Down Timbuktu Pro when Main Window
Closes option on the General tab in the Preferences dialog box. See “General
Preferences” on page 24.

EXITING TIMBUKTU PRO FROM THE FILE MENU

The Timbuktu Pro File menu has two exit options: Exit and Exit and Shut Down
Timbuktu Pro.

Edit View Setup Services Connections

Open Address Book...
Close Address Book

Properties... Alt+Enter
Delete Del

Exit and Shut Down Timbuktu Pro  Alt+Ctrl+F4
Exit Alt+F4

ExiT TIMBUKTU PRO OPTION
To exit without shutting down Timbuktu Pro, click the File menu and choose Exit.

Exiting Timbuktu Pro closes the main Timbuktu Pro window. The Timbuktu Pro
icon appears in the system tray on the Windows taskbar to remind you that Tim-
buktu Pro can still accept incoming connections. Double-click the taskbar icon to
reopen the main Timbuktu Pro window.
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EXIT AND SHUT DOWN TiIMBUKTU PRO OPTION

To shut Timbuktu Pro down completely, click the File menu and choose Exit and
Shut Down Timbuktu Pro.

When you exit and shut down Timbuktu Pro, any active connections are shut
down. Remote users will not be able to initiate new connections with your
computer.

You can also shut down Timbuktu Pro by right-clicking the Timbuktu Pro icon in
the system tray on the taskbar. From the shortcut menu, choose Exit and Shut
Down Timbuktu Pro.

CUSTOMIZING YOUR TIMBUKTU PRO PREFERENCES

The Preferences dialog box lets you specify certain configuration options for Tim-
buktu Pro. To open the Preferences dialog box, click the Setup menu and choose
Preferences. The tabs in the Preferences dialog box are as follows:

e General—Timbuktu Pro general, startup, and shutdown preferences. See
page 24.

e Observe/Control Host—Screen-sharing window preferences for when your
computer acts as the Host computer. See page 26.

* Observe/Control Guest—Screen-sharing window preferences for when your
computer acts as the Guest computer. See page 31.

e Send—Send service preferences. See page 35.

¢ Notify—Notify service preferences. See page 37.

e Master Password—An optional password restricting access to Timbuktu Pro’s
Preferences, Security, and LDAP Options dialog boxes. See page 38.

e Skype—Skype preferences. See page 39.

e Dial Direct—Dial Direct preferences. See page 40.

e logging—Logging preferences. See page 42.

Note: LDAP preferences are set in the LDAP Options dialog box. See “Setting
LDAP Options” on page 44.

The following sections describe each of these tabs.
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GENERAL PREFERENCES

The General tab lets you specify preferences for starting up and shutting down
Timbuktu Pro. You can also enter information for the Internet Locator Server.

TO CHANGE YOUR GENERAL PREFERENCES

1. From the Setup menu, choose Preferences.
2. Inthe Preferences dialog box, click the General tab.

Notify ] Master Password ] Skype ] Dial Direct ] Logging ]
General l Observe/Control Host ] Observe/Control Guest ] Send ]

Computer Name |spark|es Reset

[+ Start Timbuktu Pro as a service

[ Shut down Timbuktu Pro when main window closes

On Launch: Hide Window ﬂ

Internet Locator

[v Internet Locator enabled

Email Address: |1b2@netopia.com Reset
OK | Cancel ‘ Apply ‘ Help ‘

3. Specify the Timbuktu Pro Computer Name. The name of your computer identi-
fies your computer to other Timbuktu Pro computers.

The computer name does not need to be the same as your Windows network-
ing computer name. However, if you have previously changed the computer
name and now wish to set it to the Windows name, click Reset.

4. If you want the Timbuktu Pro application to be started as a service, select
Start Timbuktu Pro as a Service. For more information, see the following sec-
tion, “Launching Timbuktu Pro as a Service.”
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By default, Timbuktu Pro is started as a service, which makes it available at
the network logon prompt. Your Timbuktu Pro will be able to accept incoming
connections before you log in to Windows.

5. If you want to shut down Timbuktu Pro when you click the Close box in the
upper-right corner of the main Timbuktu Pro window, select Shut Down Tim-
buktu Pro when Main Window Closes.

By default, when you click the Close box, the Timbuktu Pro window is closed
but Timbuktu Pro remains running. See “Exiting and Shutting Down Timbuktu
Pro” on page 22 for discussion of the difference between exiting and shut-
ting down.

6. Select an On Launch option to specify whether the main Timbuktu Pro win-
dow will open when Timbuktu Pro is started.

Hide Window—The main Timbuktu Pro window will not open.
Show Window—The main Timbuktu Pro window will open.

Use Previous State—The main Timbuktu Pro window will open if it was open
when Timbuktu Pro was last shut down. Otherwise, it will not open.

7. Select Internet Locator Enabled and enter your email address if you want to
use the Internet Locator service on your computer. For information about the
Internet Locator server, see “The Internet Locator” on page 26.

Click Reset to set the email address to the email address stored in the Win-
dows registry.

8. Click OKto save your changes and close the Preferences dialog box.

LAUNCHING TIMBUKTU PRO AS A SERVICE

By default, the Timbuktu Pro application is launched as a service. It is started au-
tomatically as soon as Windows has loaded on your computer, and before Win-
dows requires you to log in. This lets you control your computer remotely and
enter your Windows user name and password, just as if you were sitting at the
computer, or use services such as Exchange without logging in to Windows at all.

If you prevent Timbuktu Pro from starting automatically, you must start it manually.
See “Starting Timbuktu Pro Manually” on page 21. Note that if Timbuktu Pro does
not start automatically, you will not be able to control your computer remotely af-
ter a restart.
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THE INTERNET LOCATOR

Netopia’s Internet Locator server allows you to connect to other Timbuktu Pro
computers using an email address instead of an IP address. This is particularly
helpful when a remote computer is connected to an Internet Service Provider (ISP)
that assigns dynamic IP addresses. You can enter the remote user’s email ad-
dress on the TCP/IP tab in the main Timbuktu Pro window and then select a ser-
vice. The Internet Locator server translates the email address to the correct IP
address and makes the connection using the service you selected.

Netopia maintains an Internet Locator server for public use. (Its DNS name is
findme.netopia.com.) When the Internet Locator service is enabled on your com-
puter and you launch Timbuktu Pro while connected to the Internet, your email
address and the associated IP address are automatically sent to the server. Other
Timbuktu Pro users can then connect to you by entering your email address on
the TCP/IP tab.

OBSERVE/CONTROL HOST PREFERENCES

Timbuktu Pro Control and Observe sessions take place in a screen-sharing
window, which displays the remote computer’s desktop on your screen. The
Observe/Control Host tab in the Preferences dialog box lets you specify options
that may improve screen-sharing performance and security when remote users
use the Control or Observe service with your computer.

Timbuktu Pro also supports secure screen blanking. Secure screen blanking is a
Timbuktu Pro security feature that prevents unauthorized viewing of your com-
puter’s screen while it is being controlled by a remote user. For more information,
see “Secure Screen Blanking” on page 30.

To CHANGE YOUR OBSERVE/CONTROL HOST PREFERENCES

1. From the Setup menu, choose Preferences.
2. Inthe Preferences dialog box, click the Observe/Control Host tab.
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Preferences R|
Notify ] Master Password ] Skype ] Dial Direct ] Logging ]
General Observe/Contral Host l Observe/Control Guest ] Send ]

When users Observe/Control my computer:

Security
[ Blank my screenwhen users control my computer

[ Lock my computer when users end control sessions

[v  Allow controlling users to request screen blanking

Capture Technique Presentation

[v Use accelerated capture |v Disable desktop wallpaper
[ Use capture frame |[v' Disable Active Desktop

[v Use DirectDraw [v Disable animations

[v' Use hint provider [v' Disable full window drag

[v Disable screen saver

[v "Kill" screen saver

Filter: |None hd
0K | Cancel ‘ Apply ‘ Help ‘

3. Inthe Security area

e Select Blank My Screen when Users Control My Computer to activate
secure screen blanking automatically when a remote user observes or
controls you computer.

Secure screen blanking is a Timbuktu Pro security feature that prevents
unauthorized viewing of a computer’s screen while it is being controlled
by a remote user. See “Secure Screen Blanking” on page 30.

When this option is selected, your screen will blank even if you are work-
ing at your computer. You may wish to select this option only if you are
the only person who uses Timbuktu Pro to access your computer
remotely.

When this option is not selected, you screen will not blank automatically.
However, remote users can still choose to blank your screen if you select
the Allow Controlling Users to Request Screen Blanking option, which is
discussed below.
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e Select Lock My Computer When Users End Control Sessions to lock your
computer when an incoming Control session is complete.

For example, if the Help desk is installing new software or doing exten-
sive configuration of your system, you may need to leave your computer
before the installation is complete. When the remote user finishes con-
trolling your computer and disconnects, your computer is locked auto-
matically and remains secure until you return (as if you had pressed
CTRL+ALT+DEL and chosen Lock Workstation).

e Select or clear Allow Controlling Users to Request Screen Blanking to
specify whether remote users can force your screen to blank when they
control your computer.

When this option is selected, a remote user can force your screen to
blank even if you are working at your computer. You may wish to select
this option only if you are the only person who uses Timbuktu Pro to ac-
cess your computer remotely.

When this option is not selected, remote users cannot choose whether to
blank your screen. However, your screen will still block automatically if
you selected the Blank My Screen when Users Control My Computer
option.

Note that these options are not available when you select the Use Capture
Frame option in the Capture Technique area.

4. Inthe Capture Technique area

e Select UseAccelerated Capture to use the video-driver-based remote
control component, which increases Timbuktu Pro’s screen-sharing per-
formance. Clear this check box to use the Universal Remote Control
Adapter, which makes Timbuktu Pro more compatible with different
video cards and video settings.

The Universal Remote Control Adapter also supports systems with multi-
ple monitors. If you have a multiple-monitor setup, disable the Use Accel-
erated Capture option.

e Select the Use Capture Frame option to restrict the view of your desktop
when a remote computer establishes a Control or Observe connection to
your computer. During the screen-sharing session, only the portion of
your desktop that appears in the Capture Frame is displayed in the
screen-sharing window on the remote computer. For details, see the fol-
lowing section, “Enabling the Remote Control Capture Frame.”
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e Select or clear Use DirectDraw to enable or disable the use of DirectDraw
(which allows Timbuktu Pro to send screen information directly to the
video adapter). In most cases, you will not need to disable this option.

e Select or clear Use Hint Provider to enable or disable the use of Hint Pro-
vider (which allows Timbuktu Pro to access application messages). In
most cases, you will not need to disable this option.

In the Presentation area, select or clear the appropriate check boxes to set
options as desired.

The Presentation settings allow you to control the appearance and behavior
of your desktop while remote users are observing or controlling your com-
puter. Most of the Presentation options, when selected, will increase the
screen-sharing performance of Timbuktu Pro during remote-control sessions.

e Disable Desktop Wallpaper removes the Windows wallpaper from your
desktop while a remote user is controlling or observing your computer.
The wallpaper is restored when the remote control session ends.

e Disable Active Desktop disables Active Desktop on your computer while a
remote user is controlling or observing your computer. Active Desktop is
restored when the remote control session ends.

e Disable Animations disables desktop animations on your computer while
a remote user is controlling or observing your computer. Desktop anima-
tions are restored when the remote control session ends.

e Disable Full Window Drag disables full window drag (in which the win-
dow’s contents are displayed while it is dragged) on your computer while
a remote useris controlling or observing your computer. Full window drag
is restored when the remote control session ends.

e Disable Screen Saver prevents the screen saver from running on your
computer while a remote user is controlling or observing your computer.

e “Kill” Screen Saver deactivates the screen saver on your computer at the
start of an incoming remote control session.

In the Presentation area, select an option from the Filter drop-down list. The
Filter option forces a color-depth reduction before screen-sharing data is sent
from your computer to the guest computer. (The Loss-Less option disables
color-depth reduction.)

Click OK to save your changes and close the Preferences dialog box.
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ENABLING THE REMOTE CONTROL CAPTURE FRAME

When you enable the Use Capture Frame option on the Observe/Control tab in the
Preferences dialog box, the Capture Frame will open on your desktop when a re-
mote computer establishes a Control or Observe connection to your computer.

The Capture Frame restricts the remote user’s view of your desktop. During the
screen-sharing session, only the portion of your desktop that appears in the Cap-
ture Frame is displayed in the screen-sharing window on the remote computer.

When a remote user connects to your computer, the screen-sharing session will
not begin until you click the Play button in the upper-left corner of the Capture
Frame. This allows you to position the Capture Frame as needed before screen-
sharing begins.

Note: Do not enable the Use Capture Frame option if anyone will need to use the
Control or Observe service to access your computer when you are not present.
Because you must click the Play button to allow the screen-sharing session to
proceed, you must be physically present at the host computer.

For additional information about using the Capture Frame, see “Using the Cap-
ture Frame” on page 78.

SECURE SCREEN BLANKING

Secure screen blanking is a Timbuktu Pro security feature that prevents unautho-
rized access to your computer while it is being controlled by a remote user. When
secure screen blanking is active, no one will be able to see what is happening on
the computer’s desktop. (They may be able to see the cursor move and hear any
audio the computer generates.)

Secure screen blanking works differently in different situations: whether or not
you are logged in to your computer, and—if you’re logged in—whether or not your
computer is locked before the remote user takes control.

You should always protect the security of your computer by using a password-pro-
tected screen saver. When you are away from your computer, the locking mecha-
nism will help to ensure your security.

WHEN YOU’RE WORKING AT YOUR COMPUTER

If you are working at your computer and a remote user controls it (for example, the
Help Desk takes control to troubleshoot a problem you’re having), the screen will
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not blank. You will be able to watch the remote user’s actions and, if necessary,
disconnect the user from your computer.

Note: Your screen will blank, even if you are using your computer, if you selected
the Allow Controlling Users to Request Screen Blanking option and the remote
user requests the screen to blank.

WHEN YOUR SCREEN IS LOCKED

If your computeris locked and a remote user controls it, the screen will blank. You
will not be able to activate your monitor until the remote user disconnects. When
the remote user ends the control session, the Workstation Locked dialog box will
reappear.

WHEN YOU HAVEN’T LOGGED IN

If you have not logged in to your computer and a remote user controls it, the
screen will blank. You will not be able to activate your monitor until the remote
user disconnects. When the remote user ends the control session, the Logon In-
formation dialog box will reappear.

OBSERVE/CONTROL GUEST PREFERENCES

Timbuktu Pro Control and Observe sessions take place in a screen-sharing
window, which displays the remote computer’s desktop on your screen. The
Observe/Control Guest tab in the Preferences dialog box lets you control the ap-
pearance and behavior of the screen-sharing window. You may specify options
that may improve screen-sharing performance and security during screen-sharing
sessions.

Timbuktu Pro also supports secure screen blanking. Secure screen blanking is a
Timbuktu Pro security feature that prevents unauthorized viewing of your com-
puter’s screen while it is being controlled by a remote user. For more information,
see “Secure Screen Blanking” on page 30.

To CHANGE YOUR OBSERVE/CONTROL GUEST PREFERENCES

1. From the Setup menu, choose Preferences.
2. Inthe Preferences dialog box, click the Observe/Control Guest tab.
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Notify ] Master Password ] Skype ] Dial Direct ] Logging ]
General |  Observe/Control Host Observe/Control Guest ] send |
Window
[v Automatically scroll [~ Always on top [ Shrink to fit
[v Show scrollbars [ Start maximized
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When controlling, requestthe other computer to:

Security: Presentation:
[ Blankthe screen [+ Disable desktop wallpaper
Capture Technique: [v Disable Active Desktop

[v Use accelerated capture e D!Sable aﬂlm.atlons
@ (U= Glies e [v Disable full window drag

¥ Use hint provider [v Disable screen saver

= [v "Kill" screen saver
Keyboard handling:

[v Use logical keyboard Filter. |N0ne ﬂ
[v' Synchronize lock states
[ Map control key to command key

OK | Cancel Apply Help

3. Inthe Window area

Select Automatically Scroll to scroll the screen-sharing window automati-
cally when your mouse pointer approaches the edge of the window or
when the pointer on the remote desktop moves out of view.

If this option is not selected, automatic scrolling will not occur. You can
scroll the window manually by clicking on the scroll bars at the edge of
the window.

Note: Because there are no scroll bars when a screen-sharing window is
maximized, a maximized window always scrolls automatically.

Select Show Scrollbars to display scroll bars in the screen sharing win-
dow. (When the screen-sharing window is maximized, scroll bars will not
appear, even when this option is selected.)

Select Always On Top to force the screen sharing window to remain on
top of all other application windows.
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e Select Start Maximized to start screen-sharing sessions with the screen-
sharing window maximized.

e Select Shrink to Fit to shrink (or enlarge) the image of the remote desktop
to fit entirely within the screen-sharing window. If you reduce or enlarge
the window, the remote desktop will resize automatically to fit. However,
the remote desktop will never be enlarged beyond its actual size.

In the Keyboard area

e Select Map Control Key to Command Key to specify that your CTRL key
acts as the COMMAND key when you control a Macintosh computer.

e Select Use Logical Keyboard to use logical keyboard mapping if the host
and guest computers use different keyboard types. For example, if the
host computer uses a Qwerty keyboard and the guest computer uses a
Dvorak keyboard, pressing the Y key on the guest computer will have the
same effect as pressing the Y key on the host computer.

Physical mapping, which is used if this option is not selected, maps keys
based on their physical location on the keyboard. For example, if the
host computer uses a Qwerty keyboard and the guest computer uses a
Dvorak keyboard, pressing the Y key on the guest computer will be trans-
lated as a T on the host computer.

e Select Synchronize Lock States to match the CAPS LOCK, NUM LOCK, and
SCROLL LOCK settings on the host computer to the settings on the guest
computer. This matching occurs as soon as you press a key while the
screen-sharing window is in focus.

If this option is not selected, the host computer’'s CAPS LOCK, NUM LOCK,
and SCROLL LOCK settings will not change.

In the Security area, select Blank the Screen to activate secure screen blank-
ing when you Observe or Control another computer. Secure screen blanking
is a Timbuktu Pro security feature that prevents unauthorized viewing of a
computer’s screen while it is being controlled by a remote user. See “Secure
Screen Blanking” on page 3o0.

Note: Screen blanking will occur only if the host computer allows it. If the
Blank My Screen when Users Control My Computer setting is enabled, blank-
ing will occur whether or not you request it. If the Blank My Screen setting is
not enabled, the screen will blank only if the user of the host computer has
enabled the Allow Controlling Users to Request Screen Blanking setting.
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In the Capture Technique area

e Select UseAccelerated Capture to use the video-driver-based remote
control component, which increases Timbuktu Pro’s screen-sharing
performance. Clear this check box to use the Universal Remote Control
Adapter, which makes Timbuktu Pro more compatible with different
video cards and video settings.

The Universal Remote Control Adapter also supports systems with multi-
ple monitors. If you have a multiple-monitor setup, disable the Use Accel-
erated Capture option.

e Select or clear Use DirectDraw to enable or disable the use of DirectDraw
(which allows Timbuktu Pro to send screen information directly to the
video adapter). In most cases, you will not need to disable this option.

e Select or clear Use Hint Provider to enable or disable the use of Hint Pro-
vider (which allows Timbuktu Pro to access application messages). In
most cases, you will not need to disable this option.

Note: If these settings are not enabled on the host computer, but enabled on
the guest computer, the guest settings will be used during the screen-sharing
session. However, if these settings are enabled on the host computer, the
guest computer cannot disable them.

In the Presentation area, select or clear the appropriate check boxes to set
options as desired.

The Presentation settings allow you to control the appearance and behavior

of the remote desktop while you observe or control a remote computer. Most
of the Presentation options, when selected, will increase the screen-sharing

performance of Timbuktu Pro during remote-control sessions.

e Disable Desktop Wallpaper removes the Windows wallpaper from the
host computer’s desktop when you are controlling or observing the
computer.

e Disable Active Desktop disables Active Desktop on the host computer
when you are controlling or observing the computer.

e Disable Animations disables desktop animations on the host computer
when you are controlling or observing the computer.

e Disable Full Window Drag disables full window drag (in which the win-
dow’s contents are displayed while it is dragged) on the host computer
when you are controlling or observing the computer.
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e Disable Screen Saver prevents the screen saver from running on the host
computer while you are controlling or observing the computer.

e “Kill” Screen Saver deactivates the screen saver on the host computer at
the start of the remote control session.

Note: If these settings are not enabled on the host computer, but enabled on
the guest computer, the guest settings will be used during the screen-sharing
session. However, if these settings are enabled on the host computer, the
guest computer cannot disable them.

8. Inthe Presentation area, select an option from the Filter drop-down list. The
Filter option forces a color-depth reduction before screen-sharing data is sent
from the host computer to your computer.

During the remote-control session, Timbuktu Pro checks the Filter setting on
both the host and guest computer. The more restrictive (faster) setting is
used.

9. Click OKto save your changes and close the Preferences dialog box.

SEND PREFERENCES

The Send service lets you send messages called FlashNotes to other Timbuktu Pro
computers. You can customize Timbuktu Pro to notify you of an incoming
FlashNote by displaying the FlashNote in a full-sized window or by displaying the
FlashNote as a minimized icon on the taskbar. In addition, you can designate how
much of your disk space should be protected from temporary storage of
FlashNotes and their enclosures.

TO CHANGE YOUR SEND PREFERENCES

1. From the Setup menu, choose Preferences.
2. Inthe Preferences dialog box, click the Send tab.
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Preferences R|
Notify ] Master Password ] Skype ] Dial Direct ] Logging ]
General ] Observe/Control Host ] Observe/Control Guest Send

When a note arrives on my computer
i@ Showin a full-sized window

(~ Show as a minimized icon

Disk Usage
Megabytes of disk space protected from use by FlashMotes: 0

Save files inside this folder:
|C:\PROGRAM FILES\TIMBEUKTU PRO

Browse..
oK | Cancel ‘ Apply ‘ Help ‘

In the When a Note Arrives on My Computer area, select Show in a Full-Sized
Window to see newly received FlashNotes and attached enclosures
immediately. Select Show as a Minimized Icon to display the FlashNote as an
icon in the taskbar. The icon indicates that a message has arrived.

In the Disk Usage area

e To limit the amount of disk space used by files sent by the Send service,
enter the desired number of megabytes in the Megabytes of Disk Space
Protected from Use by FlashNotes field. This prevents users from entirely
filling up your disk with FlashNotes and enclosures.

e Files transferred using the Send function are stored in the files received
folder. Specify the location of the files received folder on your computer
in the Save Files Inside this Folder field.

If someone attempts to send files or folders that would require more disk
space on your computer than is available, Timbuktu Pro notifies them that
there isn’t enough disk space to carry out the file transfer.

This option does not restrict file transfer using the Exchange service.
Click OK to save your changes and close the Preferences dialog box.
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NOTIFY PREFERENCES

The Notify service lets remote users request notification when your computer be-
comes active. Timbuktu Pro can prompt you before responding to a notification
request or respond automatically based on mouse and keyboard activity.

To CHANGE YOUR NOTIFY PREFERENCES

1. From the Setup menu, choose Preferences.
2. Inthe Preferences dialog box, click the Notify tab.

General ] Observe/Control Host ] Observe/Control Guest ] Send ]
Notify l Master Password ] Skype ] Dial Direct ] Logging ]

If someone asks to be notified when | become active

(& Promptme for an answer

(" Answer automatically (based on mouse and keyboard activity)

When someone asks to be notified, tell them...

[ Whenlastused my computer.

[ Message: |Conference call daily 3-10 AM.

0K | Cancel ‘ Apply Help

3. Inthe /f Someone Asks to be Notified when | Become Active area

e Select Prompt Me for an Answer if you do not want Timbuktu Pro to auto-
matically notify users that you have become active. You can choose to
notify or not to notify the user that you are available at your computer.

e Select Answer Automatically if to allow all users to whom you’ve granted
the Notify service to know when your computer has become active. When
a remote user asks for notification, Timbuktu Pro will notify that user that
you have become active without telling you who is asking for notification.

4. Inthe When Someone Asks to be Notified, Tell Them area

e Select When I Last Used my Computer to display this information to the
remote user. The user will be told the date and time when you last used
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your mouse or keyboard. (If you selected Prompt Me for an Answer in
step 3, and you choose not to notify a remote user that your computer
has become active, the date and time of your last activity will not be
updated on the remote computer when you become active.)

e Select Message and enter a message to be displayed when the remote
user asks for notification.

5. Click OKto save the changes and close the Preferences dialog box.

SETTING UP YOUR MASTER PASSWORD

Use a master password to protect access to those parts of Timbuktu Pro that allow
you to change Timbuktu Pro’s configuration—the Security, Preferences, and LDAP
Options dialog boxes. After you created a master password, Timbuktu Pro will ask
you to type it whenever you attempt to open these dialog boxes.

Be sure you choose a password you will remember. If you forget your master pass-
word, you will need to uninstall and reinstall Timbuktu Pro.
TO SET OR CHANGE YOUR MASTER PASSWORD

1. From the Setup menu, choose Preferences.
2. Ifyou have an existing master password, enter it when prompted.
3. Inthe Preferences dialog box, click the Master Password tab.

Preferences §|
General ] Observe/Control Host ] Observe/Control Guest ] Send ]
Notify Master Password ] Skype | DialDirect | Logging |

Setthe Master Password

The Password and Confirm boxes must be identical or blank.

|

Password:

Confirm: |

Master Password protects access to Preferences and Security windows

OK | Cancel Apply Help
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4. Typethe new password in the Password box. The characters you enter are dis-
played as asterisks. Passwords are case-sensitive.

5. Re-type the master password in the Confirm box.
6. Click OKto save the changes and close the Preferences dialog box.

Timbuktu Pro will not let you close the Preferences dialog box unless the
Password and Confirm fields match exactly.

REMOVING YOUR MASTER PASSWORD

If you wish to unprotect your Security, Preferences, and LDAP settings, you may re-
move your master password.

To REMOVE YOUR MASTER PASSWORD

1. From the Setup menu, choose Preferences.

2. When prompted, enter your existing master password.

3. Inthe Preferences dialog box, click the Master Password tab.

4. Delete the text from both the Password and Confirm boxes.

5. Click OKto save your changes and close the Preferences dialog box.

SETTING SKYPE PREFERENCES

The Skype tab in the Preferences dialog box lets you determine whether your Tim-
buktu Pro will allow incoming and outgoing Skype connections.

By default, Timbuktu Pro will not allow incoming Skype connections. If you wish to
accept Skype connections, you must change your Skype options in the Prefer-
ences dialog box.

TO CHANGE YOUR SKYPE OPTIONS

1. From the Setup menu, choose Preferences.
2. Inthe Preferences dialog box, click the Skype tab.
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General ] Observe/Control Host ] Observe/Control Guest ] Send l
Notify ] Master Password Skype l Dial Direct ] Logging ]

[v Enable Skype integration

[v Enable incoming access via Skype

OK | Cancel Apply Help

e Select the Enable Skype Integration option to enable the Skype feature.
The Skype Contacts tab will appear in the main Timbuktu Pro window,
allowing you to use the Skype transport for outgoing connections, and
the Skype Call and Skype Chat services will be available.

e Select the Enable Incoming Access via Skype option to allow incoming
Skype connections. This option is available only if you select the Enable
Skype Integration option.

3. Click OKto save your changes and close the Preferences dialog box.

SETTING DIAL DIRECT PREFERENCES

The Dial Directtab in the Preferences dialog box lets you determine how incoming
calls are answered by your system. It also allows you to specify the modem that
will be used and how idle connections are handled.

By default, Timbuktu Pro will not answer incoming Dial Direct calls. If you wish to
accept Dial Direct connections, you must change your Dial Direct options in the
Preferences dialog box.

To CHANGE YOUR DIAL DIRECT OPTIONS

1. From the Setup menu, choose Preferences.
2. Inthe Preferences dialog box, click the Dial Direct tab.
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Preferences B|
General ] Observe/Control Host ] Observe/Control Guest ] Send ]
Notify ] Master Password ] Skype Dial Direct l Logging ]

Device: |Ccnexant D480 MDC V.9x Modem ﬂ Properties...

Onincoming calls:

i~ Do notanswer
(@ Answer after |1 rings

[ Disconnectcall ifidle for o minutes

0K | Cancel Apply Help

3. Select the modem you wish to use from the Device drop-down list. Timbuktu
Pro will list the available modems as determined by your operating system. If
you need to set or change the properties of the selected modem, click the
Properties button. (See your modem documentation for a discussion of the
information required in the Modem Properties dialog box.)

4. Under On Incoming Calls, choose an option to answer calls to your computer.

e Choose Do Not Answer to ignore all incoming calls. This is the default
option.

e Choose Answer After n Rings to answer calls automatically after the num-
ber of rings specified in the text box.

5. If you wish to automatically close an idle connection after a specific amount
of time, select the Disconnect Call checkbox and specify the number of min-
utes of inactivity after which the connection will automatically be terminated.

You may wish to automatically disconnect idle callers to allow another user
access when the current user is idle for long periods or forgets to disconnect.

6. Click OKto save your changes and close the Preferences dialog box.

DIALING PROPERTIES

To make outgoing connections, you may also need to set options—such as a dial-
ing prefix—in the Dialing Properties dialog box. You can open the Dialing Proper-
ties dialog box by clicking the Dialing Properties button on the Dial Direct tab in
the main Timbuktu Pro window. See your Windows or modem documentation for
more information about the Dialing Properties dialog box.
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LOGGING PREFERENCES

Timbuktu Pro supports multiple options for local and centralized event logging.

Among other options, you may specify the maximum size for your log files. When
the maximum size for the active log file is reached, its contents are copied to a
backup file and removed from the primary file. This allows the primary file to re-
main small, which may improve performance if you use centralized logging.

Note: Depending on your Timbuktu Pro installation, the Logging tab may not
appear.

For information about logging options, see “Timbuktu Pro Logging” on page 103.

To CHANGE YOUR TIMBUKTU PRO LOGGING OPTIONS

1. From the Setup menu, choose Preferences.
2. Inthe Preferences dialog box, click the Logging tab.

Preferences §|
General ] Observe/Control Host ] Observe/Control Guest ] Send ]
Notify ] Master Password ] Skype ] Dial Direct Logging
[v Use Timbukiu Log Server. [ Use NT EventLog Server.

[v Enable eventlog file:

Maximum size: 16384 KB Browse...

[v' Log configuration changes to these settings

AdmitTempGuest EnableBlankWorkstation TimbuktuName ~
NolLaunchAtBoot LocatorFeatureOn EmailAddress DropFolder
DropFolderProtection ReportLastActive ReportMessage AutoAnswer s

Activity log maximum size: |32 KE (or 0 forunlimited log size)

oK | Cancel ‘ Apply Help
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To copy information from your Timbuktu Pro activity log or Event Log file to
another Timbuktu Pro computer, select the Use Timbuktu Log Server check-
box. Then enter the remote computer’'s Windows name in the text box.

The “server” does not need to be a Windows server. However, the computer
you specify must be running Timbuktu Pro, and it must be visible to your com-
puter. Logging information from your computer will be written to the remote
activity log automatically, and to the remote Event Log file if one is configured
for the remote computer.

To copy information about Timbuktu Pro events from your Windows Applica-
tion Event Log to the Application Event Log on another Timbuktu Pro com-
puter, select the Use NT Event Log Server checkbox.

The Enter NT Event Log Server dialog box opens. Enter the remote computer’s
Windows name and your administrator-level user name and password.

Note: To enable remote Application Event logging, you must have

e Administrator privileges on the remote computer
e Interactive login privileges on the Windows domain
e Access to the Windows Application Event Log on the remote computer

To create an Event Log file, a text document which records the same informa-
tion that Timbuktu Pro records in the Windows Application Event Log, select
the Enable Event Log File checkbox.

Then specify the log file location and enter a maximum size for the log file in
the Maximum Size text box.

When the maximum size for the active log file is reached, its contents are
copied to a backup file and removed from the primary file. This allows the pri-
mary file to remain small.

Select the Log Configuration Changes to These Settings checkbox to specify
that configuration changes should appear in the log. Changes to the settings
listed in the Value Names text box will be logged.

Enter the maximum size for the activity log in the Activity Log Maximum text
box.

When the maximum size for the active log file is reached, its contents are
copied to a backup file and removed from the primary file. This allows the pri-
mary file to remain small.

Click OK to save your changes and close the Preferences dialog box.
Shut down and restart Timbuktu Pro to enable the new settings.
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SETTING LDAP OPTIONS

To use the LDAP server’s search functionality, you will need to set your prefer-
ences and user information in the LDAP Options dialog box. From the Setup
menu, choose LDAP.

LDAP Options Bl
General lAdvanced] User's Proﬁle]

[+ Enable LDAP directory feature

Server information

Server name: |daptestnetopia.com
[ Active Directory Server

r

OK | Cancel Apply Help

The three tabs in the LDAP Options dialog box—General, Advanced, and User’s
Profile—allow you to enable the LDAP functionality, determine port usage, and
provide your own user information to the search tools on the server.

GENERAL TAB

Click the General tab to enable the LDAP Directory feature and specify a server.
Netopia’s public LDAP server is located at Idaptest.netopia.com.

ADVANCED TAB

Click the Advanced tab to change the default LDAP contact port number and LDAP
search base. You should not need to change the information on this tab unless
you are a system administrator. The default port number is 389, and the default
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search base is o=timbuktu. This port and search information is required for suc-
cessful access to Netopia’s public LDAP server.

USER’S PROFILE TAB

Click the User’s Profile tab to provide the user information that you want to regis-
ter with the LDAP server. The information you provide will be saved to the server,
and it will be queried when another user searches the server.

To CREATE YOUR LDAP USER PROFILE

1. From the Setup menu, choose LDAP.
2. Inthe LDAP Options dialog box, click the User’s Profile tab.

LDAP Options X

General ] Advanced User's Profile ]

User's Name: |Aria| Scott

E-mail Address: | aria@th2.com

Location: |N0r‘th Building, 3rd Floor

Comment: Conference call daily 3PM.

0K | Cancel Apply Help

3. Enterthe appropriate information in each field. All information is optional.
However, complete and accurate information will make it easier for other
users to find your computer quickly.

4. Choose OKto save your changes and close the LDAP Options dialog box.
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CONTROLLING ACCESS TO YOUR COMPUTER

There are several ways of maintaining security and restricting access to your com-
puter by other Timbuktu Pro computers. You may use a master password to pre-
vent anyone with direct access to your computer from changing your Timbuktu Pro
preferences. See “Setting Up Your Master Password” on page 38.

By default, Timbuktu Pro will not accept any connections that use the Skype or
Dial Direct transports. To enable these connections, you must set the appropriate
options on the Skype and Dial Direct tabs in the Preferences dialog box. See “Set-
ting Skype Preferences” on page 39 and “Setting Dial Direct Preferences” on
page 40.

In addition, no remote user can connect to your computer without your prior au-
thorization. There are several levels of remote access: you may assign privileges
to all Guest Users, allow remote users to ask for permission to use unassigned
services, and create Registered Users and Windows NT Users with specific privi-
leges. The setup of various security measures is discussed in detail in Chapter 6,
“Security.”

As an administrator, you may also use Active Directory Group Policies and Site
Keys to control security settings on your entire network. Full documentation for
Timbuktu Pro with Active Directory is available. See the “Using Timbuktu Pro with
Active Directory” PDF document on your Timbuktu Pro CD or on the Timbuktu Pro
Enterprise Resource Center. Site Key documentation is also available on the Tim-
buktu Pro Enterprise Resource Center.



CHAPTER 4: MAKING A TIMBUKTU PRO CONNECTION

This chapter discusses how you can use the connection tabs in the main Tim-

buktu Pro window to connect to remote computers.

THE MAIN TIMBUKTU PRO WINDOW

Menus

Service
buttons

Connection
tabs

Address Book —

drop-down list

Address List
box

Status bar

When you open Timbuktu Pro, you will see the following window.
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|47
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MENUS

Use Timbuktu Pro menus to make connections, customize your Timbuktu Pro, and
define users. For more information about each menu, see “Menus in Timbuktu
Pro” in the Timbuktu Pro online Help.

SERVICE BUTTONS

You can use service buttons as shortcuts for the Send, Exchange, Observe, Con-
trol, Notify, Chat, Intercom, Invite, and Skype options in the Services menu. All the
service buttons remain dimmed until you have entered or selected an address in
one of the connection tabs. For details, see “Timbuktu Pro Service Toolbar” in the
online Help.

CONNECTION TABS

You can use the connection tabs to enter or select the addresses of other Tim-
buktu Pro computers you wish to connect to. To bring a tab to the front, click it.

The fact that a remote address is displayed in one of the connection tabs does not
automatically enable you to connect to that computer. Addresses remain visible
in the Address Books and Recent Connections tabs even when the computers at
those addresses are not running Timbuktu Pro or are shut down.

In addition, the user of the remote computer may not grant you permission to con-
nect using the service you have selected. To learn more about access restrictions,
see Chapter 6, “Security.”

STATUS BAR

The status bar, at the bottom of the main Timbuktu Pro window, contains two in-
formation panels. The panel on the right displays the TCP/IP address of the com-
puter. Other Timbuktu Pro users will use this address to connect to you.
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THE TiMBUKTU PRO CONNECTION PROCESS

Before you can use any Timbuktu Pro service with a remote computer, you must
establish a connection with the computer.

As long as you have been granted access as a Guest User, Ask for Permission
User, Registered User, or Windows NT User, you can connect to any computer that
is running Timbuktu Pro over a TCP/IP network. If you have a modem, you may
also make a direct modem-to-modem connection—with no network required.

SELECTING A REMOTE COMPUTER

When selecting a remote computer, you may wish to make

e Anew TCP/IP connection to a computer you have not connected to before.
Use the TCP/IP tab (see page 51) or LDAP tab (see page 57). Or use the Tim-
buktu Pro Scanner to search for the computer you need (see page 58).

e A Skype connection. The Skype Contacts tab in the New Connection window
allows you to use the Skype transport to connect to remote computers. This
may be particularly useful when you wish to connect to a computer behind a
firewall or NAT router. See page 54.

e ATCP/IP or Skype connection to a remote computer that you have connected
to before. Use the Address Books or Recent Connections tab (see page 59), or
choose a previously-used connection from the drop-down list on the TCP/IP
tab.

e ADial Direct connection. Use the Dial Direct tab (see page 66.)

CHOOSING A SERVICE

Once you have specified the remote computer you’re connecting to, you must
choose the service you wish you use.

e (lick a service button on the Services toolbar.
e Choose a service from the Services menu.

The Timbuktu Pro services are addressed in detail in Chapter 5, “The Timbuktu
Pro Services.”
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RE-ESTABLISHING AN EARLIER CONNECTION

If you’ve previously connected to the same remote computer, a record of the con-
nection and its properties will appear on the Recent Connections tab. Double-click
the selected address to connect using the default service (the service used during
the last connection or specified in its connection properties) for that address. Or
right-click the computer and choose a different service from the shortcut menu.
The connection is established using the same transport and security settings
used by the previous connection.

You may also be able to reconnect from the TCP/IP tab by clicking the TCP/IP Ad-
dress drop-down list and selecting the remote address, or from the Dial Direct tab
by clicking the Phone Number drop-down list and selecting the phone number.

Finally, you may have created an address book entry for the computer you want.
On the Address Books tab, double-click the selected address to connect using the
default service (the service used during the last connection or specified in the
connection properties) for that address. Or right-click the computer and choose a
different service from the shortcut menu. The connection is established using the
transport and security settings saved in the address book. For information about
saving connections to an address book, see “Using the Address Books Tab” on
page 61.

USING A TIMBUKTU PRO CONNECTION DOCUMENT

You may save connection properties to the desktop for quick access using a Tim-
buktu Pro Connection Document. Timbuktu Pro Connection Documents are desk-
top shortcuts that allow you to start a Timbuktu Pro connection to a specific
remote computer from a desktop icon.

To create a Connection Document, right-click over the desktop and choose

New » Timbuktu Pro Connection Document. For more information on creating, ed-
iting, and using Timbuktu Pro Connection Documents, see “Timbuktu Pro Con-
nection Documents” on page 67.
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MAKING A NEw CONNECTION

You can establish a Timbuktu Pro connection to a computer you haven’t used be-
fore in several ways. Enter its IP address, Timbuktu Pro computer name, or email
address in the TCP/IP tab. Use the Skype Contacts tab to locate a Skype user and
connect to the computer on which the user is active. Search for remote computers
meeting specific criteria in the LDAP tab. Or use the Timbuktu Pro Scanner to
search your network for active Timbuktu Pro computers.

You may also establish a Dial Direct connection. See page 66.

UsiNG THE TCP/IP TaB

The most common way to open a new Timbuktu Pro connection is to use the
TCP/IP tab in the main Timbuktu Pro window.

To MAKE A NEW CONNECTION

1. To connect to a remote computer for the first time, click the TCP/IP tab.
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2. Inthe TCP/IP Address text box, enter the IP address of the remote computer.

If you don’t know the IP address, and the Internet Locator service is enabled
on the remote computer, you may enter the computer user’s email address.

(See “The Internet Locator” on page 26 for more information about the Inter-
net Locator.) You may also enter the computer’s DNS name or WINS name if
one has been assigned.

3. Ifyou wish to use SSH to secure your connection, select the Use SSH check
box. Then enter your OS-level user name for the remote computer.

The user name that you enter must be defined in the operating system for the
remote computer. Before the connection is completed, you will be prompted
to enter the password associated with the user name you specified.

Note: To connect securely to a Macintosh computer, you must enter your Mac
0S X user name and password for that computer. In addition, the user of the
remote Macintosh computer must create a Mac OS X Registered User account
that allows you access. For details, see your Timbuktu Pro for Macintosh doc-
umentation.

For details about SSH connections, see the following section, “Connecting
Securely with SSH.”

4. Choose any service from the Services menu or click a service button.

For detailed information about each service, see Chapter 5, “The Timbuktu
Pro Services.”

5. To complete the connection to the remote computer, you may need to log on
as a Registered User or ask for permission. See “Connecting as a Registered
User or Ask for Permission User” on page 54.

CONNECTING SECURELY WITH SSH

To establish a Timbuktu Pro session with a remote computer over a secure SSH
connection, you must enter your OS-level user name for the remote computer. Be-
fore the connection is completed, you will be prompted to enter your password.

If you enter only your user name, the default SSH port is assumed and SSH au-
thentication is performed on the remote computer to which you connect. How-
ever, you may also specify the SSH port to use, the SSH address for a gateway
through which you wish to connect, or both.

Note: To connect securely to a Macintosh computer, you must enter your Mac 0S
X user name and password for that computer. In addition, the user of the remote
Macintosh computer must create a Mac OS X Registered User account that allows
you access. For details, see your Timbuktu Pro for Macintosh documentation.
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Specifying the SSH Port

To specify the SSH port, enter your user name and the SSH port in the format
username:sshport

For example, enter tb2user:3423 to use the port 3423.

If you do not specify a port, the default SSH port (22) is assumed.

Specifying the SSH Gateway

You may also establish an SSH connection through an SSH “gateway” computer.
The SSH server on the gateway computer performs the SSH authentication before
establishing the Timbuktu Pro connection to the remote computer.

For example, you may use the SSH gateway to establish a connection to a com-
puter behind a firewall by working through an SSH port in the firewall. The SSH
port connects to the SSH server behind the firewall, which can resolve the IP ad-
dress you entered for the remote computer.

To specify an SSH gateway, enter your user name and the SSH gateway address in
the format

username@sshaddress

The SSH address can be an IP number or DNS name. For example, enter
tb2user@ssh.timbuktupro.com.

If you do not specify an SSH gateway, SSH authentication is performed on the
Timbuktu Pro computer to which you connect.

Note that if you use an SSH gateway to secure your Timbuktu Pro connection, the
connection is encrypted only between your computer and the SSH gateway. The
connection from your computer is decrypted at the SSH gateway, and the connec-
tion between the gateway and the host Timbuktu Pro computer is not encrypted.

Specifying the SSH Port and the SSH Gateway

To specify both the SSH port and the SSH gateway, enter your user name and the
SSH information in the format

username@sshaddress:sshport

For example, enter tb2user@ssh.timbuktupro.com:3423.
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CONNECTING AS A REGISTERED USER OR ASK FOR PERMISSION USER

If you attempt to connect to a remote computer using a Timbuktu Pro service that
is not assigned to Guest Users, the Log In dialog box will appear on your screen.

If you have a Registered User account on the remote computer, select the Log In
as Registered User radio button. Enter your log in name and password and click
OK. (You may also change your password if desired or if prompted to do so.)

If you do not have a Registered User account, ask for permission to access the re-
mote computer. Select the Ask for Permission radio button and click OK. If the
user of the remote computer grants your request, you will be admitted.

Note: The user of the remote computer may have disabled the Ask for Permission
option. If the Ask for Permission radio button is not available, you must use other
means to contact the remote user to be granted access.

USING THE SKYPE CONTACTS TAB TO FIND A REMOTE
COMPUTER

The Skype Contacts tab in the New Connection window helps you find and con-
nect to remote computers, even when you don’t know their IP addresses, by list-
ing the users from your Skype contact list. You can select a Skype contact to
connect to the computer on which the contact is active.

When you use the Skype Contacts tab to connect to a remote computer, Timbuktu
Pro uses the Skype transport to pass connection data. This may allow you to con-
nect to Timbuktu Pro computers that are not accessible from the TCP/IP or LDAP
tab, such as computers behind NAT routers or firewalls.
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To FIND A REMOTE COMPUTER USING THE SKYPE CONTACTS TAB

1.

In the New Connection window, click the Skype Contacts tab.
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The list of users from your Skype contact list is displayed.

The Skype icon in front of each contact’s name indicates their online status.
The Timbuktu? column indicates whether or not the contact’s computer is
running a Skype-compatible version of Timbuktu Pro and accepting incoming
Timbuktu Pro connections.

In the list of Skype contacts, select a contact.

You may make a Timbuktu Pro connection to any Skype contact who is online
and whose Timbuktu? status is Yes.

If the Skype contact is online, but their Timbuktu? status is No, you may still
use the Timbuktu Pro interface to establish a Skype Call or Skype Chat
connection.

If the Skype contact is offline, you cannot establish a connection from the
Skype Contacts tab. However, the contact’s computer may still be running
Timbuktu Pro. You may be able to make a connection with another transport.

Choose any service from the Services menu or click a service button.
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For detailed information about each service, see Chapter 5, “The Timbuktu
Pro Services.”

To complete the connection to the remote computer, you may need to log on
as a Registered User or ask for permission. See “Connecting as a Registered
User or Ask for Permission User” on page 54.

You may want to save frequently-used Skype addresses in an address book for
more convenient access. See “Using the Address Books Tab” on page 61.

TROUBLESHOOTING SKYPE CONNECTIONS

If you are having trouble completing a connection from the Skype Contacts tab, re-
view the following tips for a solution to your problem.

To complete a Skype connection, Skype must be running on both computers.
Be sure you are signed in to Skype before beginning a Skype connection. If an
attempted Skype connection fails, check the Skype Contacts tab to be sure
the Skype contact is online on the remote computer.

Be sure that both computers have permission to access the Skype API (see
“Allowing Skype Access” on page 19) and that the host computer has Skype
access enabled on the Skype tab in the Preferences dialog box (see “Setting
Skype Preferences” on page 39).

When you use the Skype transport to make a Timbuktu Pro connection, the
Skype application will attempt to establish a direct connection to the remote
computer. If this fails (which may occur due to a router or firewall configura-
tion), Skype will open a relay connection, which passes through other com-
puters (the stream is encrypted to protect your data). The Skype application
limits relay connections to a maximum speed of 1 kB per second. Therefore, if
your connection is relayed, it may appear very slow.

You may confirm that the connection is relayed by using Skype to send a large
file. If the connection is relayed, Skype displays a yellow warning triangle in
the file transfer process dialog box. Place your mouse cursor over the warning
triangle to view a Skype tooltip.

If the Skype application relays your connection, you may wish to retry the
connection from a different network, if available. For example, if you are
using a wireless network, you may wish to try a wired network.

In general, Timbuktu Pro connections using the Skype transport are slower
than connections using the regular Timbuktu Pro TCP/IP transport. This is due
to Skype’s requirements for the format of the data stream.
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USING THE LDAP SERVER TO FIND A REMOTE COMPUTER

The LDAP tab in the main Timbuktu Pro window allows you to search for other Tim-
buktu Pro computers when you don’t know their IP addresses. Once the desired
computer is found, you may connect to it without leaving the LDAP tab.

Note: The LDAP tab appears only if Enable LDAP Directory Feature is selected in
the LDAP Options dialog box.

TO FIND A REMOTE USER USING THE LDAP SEARCH FEATURE

1. Inthe main Timbuktu Pro window, click the LDAP tab.
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2. Inthe Search For box, type a search string. This can be some portion of the
remote user’s login name, computer name, email address, or any other
information stored in their user profile. Enter * as a wildcard character when
you are not certain of the entire search string.

3. Click Find Now and Timbuktu Pro will search the LDAP server for users whose

profiles include your search string. Up to 500 entries will be returned, unless
your system administrator has set a different value.

4. To make a Timbuktu Pro connection to the desired computer, right-click on
the user’s name and choose a service from the shortcut menu.
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SCANNING THE NETWORK FOR TIMBUKTU PRO COMPUTERS

The Timbuktu Pro Scanner helps you find and connect to remote computers, even
when you don't know their IP addresses, by browsing your local network for active
Timbuktu Pro computers. Once the desired computer is found, you may connect
to it without leaving the Timbuktu Pro Scanner.

By default, the Timbuktu Pro Scanner scans the local TCP/IP subnet. Your system
administrator can customize and extend the range of the search.

TO MAKE A CONNECTION USING THE TIMBUKTU PRO SCANNER

1. From the Connections menu, choose Timbuktu Pro Scanner.

2. The Timbuktu Pro Scanner window opens. The search begins automatically.
The remote computers found by the Timbuktu Pro Scanner appear in the Tim-
buktu Pro Scanner window.

. Timbuktu Pro Scanner E@B|

Timbukiu Pro has been detected on:

Computer Mame | IP Address |
BLDENT 240.1.30.25
HLzak 2401.30.26
ELRINGER 24013024
BLRavN 2401.30.23
& blue 240.1.30.21
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3. When the scan is complete, the word Ready will appear in the status bar at
the bottom of the Timbuktu Pro Scanner window.

4. To make a Timbuktu Pro connection to a listed computer, right-click the com-
puter name. From the shortcut menu, choose the service you wish to use.

To complete the connection to the remote computer, you may need to log on
as a Registered User or ask for permission.
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To SAVE ADDRESSES FROM THE TIMBUKTU PRO SCANNER

Saving frequently-used TCP/IP addresses in an address book allows you more
convenient access in the future. You may save the results of a Timbuktu Pro scan
in a custom address book, enabling future connections without requiring you to
run the Timbuktu Pro Scanner. (Note that you cannot save these addresses di-
rectly to an existing address book.)

1. In the Timbuktu Pro Scanner window, click the Save button.
2. Specify a file name for the new address book and click Save.

3. If desired, edit the new address book to add additional addresses or remove
addresses you don’t need.

For more information about creating, editing, and using address books, see “Us-
ing the Address Books Tab” on page 61.

RE-ESTABLISHING A PREVIOUS CONNECTION

When you make a TCP/IP or Skype connection to a remote computer, a record of
the connection is saved to the Recent Connections tab in the main Timbuktu Pro
window. If you use the TCP/IP tab or Dial Direct tab to connect, a connection
record is saved to that tab as well. Plus, you may save previous connections to an
address book to make future connections easier.

You can select a previously connected remote computer in several different ways.

e Select an address from the Address Books tab if you have previously stored
the address in an address book. (See “Using the Address Books Tab” on
page 61.)

e Select a previously-used computer in the Recent Connections tab.

e Onthe TCP/IP tab, the last 20 connections you made are saved to the TCP/IP
Address drop-down list. Select a TCP/IP address from the list and choose a
service.

e Onthe Dial Direct tab, the last 16 telephone numbers you dialed are saved to
the Phone Number drop-down list. Select a number from the Phone Number
drop-down list and click Dial.
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USING THE RECENT CONNECTIONS TAB

The Recent Connections tab displays a record of your previous Timbuktu Pro con-
nections, including the date and time of the most recent connection and the ser-
vice you used. The Skype icon in front of the service name indicates that the
connection was made using the Skype transport. The padlock icon indicates a se-
cure SSH connection.

You may use the tab to reestablish the connection with the same service or a dif-
ferent one. The new connection will use the same transport as before.

Note: Dial Direct connections are not recorded in the Recent Connections tab. Use
the Phone Number drop-down list on the Dial Direct tab.
To RE-CONNECT TO A REMOTE COMPUTER FROM THE RECENT CONNECTIONS TAB

1. Inthe main Timbuktu Pro window, click the Recent Connections tab.
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2. Select the desired address.

Double-clicking an address on the Recent Connections tab launches the
default service for the remote computer, which is displayed in the Service col-
umn. You can also select the computer and press ENTER.

3. Click a service button to connect using the chosen service. Or right-click the
address to open a submenu from which you can choose the service to launch.
If you select multiple addresses, the same service is invoked for each.

USING THE ADDRESS BOOKS TAB

An address book is a collection of saved addresses to which you can quickly es-

tablish a Timbuktu Pro connection. Once you have added an address to your ad-
dress book, you don’t have to re-enter the address each time you connect to that
remote user.

You can add and delete addresses at any time, and you can have multiple ad-
dress books to group addresses into convenient clusters: for example, business
contacts, friends, and family.

The Address Books tab allows you to view the contents of your address books and
connect to the computers you have saved.

Each saved address includes the computer name, its connection address, and a
default service, which is the service that is used when you double-click the ad-
dress. The Skype icon in front of the service name indicates that the connection
uses the Skype transport. The padlock icon indicates a secure SSH connection.
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To CONNECT TO A SAVED ADDRESS

1.

In the main Timbuktu Pro window, click the Address Books tab.
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Select the desired address book from the Address drop-down list.

The Address drop-down list displays only the open address books. If the
address book you need does not appear, click File » Open Address Book a
navigate to the desired address book (a file with a .tbk extension) to open it.

In the list of addresses, select the desired address.

Note: Double-clicking an address on the Address Books tab launches the
default service for the remote computer, which is displayed in the Service
column.

Click a service button to connect using the chosen service. Or right-click the
address to open a submenu from which you can choose the service to launch.
If you select multiple addresses, the same service is invoked for each.

You can also select the computer and press ENTER to launch the default
service.
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Note: When an address appears in an address book, it does not guarantee that
the computer at that address is currently running Timbuktu Pro. If Timbuktu Pro is
not running on the remote computer, or if the computer is shut down, you will not
be able to connect.

SAVING AND EDITING ADDRESS-BOOK CONTACTS

You may save and edit address-book contacts at any time. Before you can save an
address to an address book, or edit a saved address, the target address book
must be open.

Note: In certain situations, TCP/IP addresses may change. For example, your orga-
nization may use dynamic TCP/IP addressing. In this situation, you may not want
to store IP addresses in Timbuktu Pro’s address books. Use the Internet Locator
email address or Skype address instead.

To OPEN AN ADDRESS BOOK

1. From the File menu, choose Open Address Book. The Open File dialog box
appears.

2. Select an address book (a file with a .tbk extension) and click Open.

The selected address book is added to the Address Book drop-down list on
the Address Books tab in the main Timbuktu Pro window.

To SAVE AN ADDRESS TO AN ADDRESS BOOK

1. Make sure the desired address book is open.
2. Select or specify the address to save in any of the following ways:

e Onthe TCP/IP tab, enter the IP address or email address you wish to
save. Or select an address from the TCP/IP Address drop-down list.

®  Onthe Recent Connections tab, click the connection you wish to save.

e Onthe Address Books tab, select an address. (You may copy a saved
address to a different address book.)

Dial Direct connections and LDAP search results cannot be saved to address
books. (Skype connections cannot be saved from the Skype Contacts tab, but
you can save them from the Recent Connections tab.)

3. Click the Copy to Address Book button.

On the Address Book or Recent Connections tab, you may also right-click the
desired connection and choose Copy To.
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In the Copy dialog box, select the address book to which you want to copy the
address. (If necessary, click Open Book to open the target address book.)
Click OK.

Timbuktu Pro attempts to contact the chosen computer to verify information
and fill in the fields of this dialog box. This may take a few seconds. If the
remote computer isn’t available, Timbuktu Pro displays default information.

The address is saved to the selected address book.

To CHANGE THE PROPERTIES OF A SAVED ADDRESS

In the main Timbuktu Pro window, click the Address Books tab.
Select the desired address book from the Address drop-down list.

The Address drop-down list displays only the open address books. If the
address book you need does not appear, click File » Open Address Book a
navigate to the desired address book (a file with a .tbk extension) to open it.

Right-click the desired address to display a shortcut menu.

Timbuktu Pro ’ send... Ctrl+S
Exchange... Ctrl+E

Copy To... Ctri+Y

) Control... Ctri+T

Properties Alt+Enter Observe... Ctr+0

Create Shortcut on Desktop

Delete Del Notify... Ctri+N
Chat... Ctri+A
Intercom...  Ctrl+M
Invite... Ctri+1
Skype Call... Ctrl+K
Skype Chat... Ctrl+Y

4. Choose Properties to modify the description, address, and default service for

5.

the selected entry. The Properties dialog box opens.
Make the desired changes in the Properties dialog box and click OK.

You may also use the shortcut menu (see step 3 above) to perform any of the fol-
lowing actions:

Choose Timbuktu Pro to access any of the Timbuktu services. If multiple ad-
dresses are selected, the service is invoked once for each address.

Choose Copy To to copy the selected address into another address book. You
can select the destination address book from the list of open address books
in the Copy window. Or choose New Book to create a new address book.
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e Choose Create Shortcut on Desktop to create a shortcut on the desktop for
the selected address.
e Choose Delete to delete the selected address from the address book.

CREATING NEW ADDRESS BOOKS

By default, Timbuktu Pro includes one address book, called Personal. You may
wish to create additional address books to organize addresses by function or
location.

TO CREATE A NEW ADDRESS BOOK
Create a new address book by beginning the save-address process.

1. Select or specify an address to save in any of the following ways:

e Onthe TCP/IP tab, enter the IP address or email address you wish to
save. Or select a previous address from the TCP/IP Address drop-down
list.

® Onthe Recent Connections tab, click the previous connection you wish to
save.

e Onthe Address Books tab, select an address. (You may copy a saved
address to a different address book.)

2. Click the Copy to Address Book button.

On the Address Book or Recent Connections tab, you may also right-click the
desired connection and choose Copy To.

3. Inthe Copy dialog box, click the New Book button.

In the New Address Book dialog box, in the File Name area, enter a name for
the new address book. Then click Save.

The new address book is created and is shown in the Copy dialog box.

5. To save the address you selected in step 1 to the new address book, click OK.
To keep the new address book without saving the selected address to it,
click Cancel.
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MAKING A DIAL DIRECT CONNECTION

The Dial Direct tab in the main Timbuktu Pro window allows you to make a direct
modem-to-modem connection to another Timbuktu Pro computer.

When using Dial Direct, no TCP/IP network connection is required. However, Dial
Direct connections use the TCP/IP protocol. You must have TCP/IP networking
software installed and configured on your computer.

Use the text boxes and drop-down lists to enter the complete phone numberyou
wish to dial. The 16 most recently dialed numbers are saved in the Phone Number
drop-down list. You cannot save Dial Direct numbers to an address book.

Note: The Dial Direct tab appears only if a Windows-recognized modem is
installed in your computer.

To ESTABLISH A DIAL DIRECT CONNECTION

1. Inthe main Timbuktu Pro window, click the Dial Direct tab.
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2. Choose a country code from the Country Code drop-down list. (This list is
maintained by the Windows 0S.)

3. Enterthe area code in the Area Code box. If you have connected to phone
numbers in this area code before, you may choose the area code from the
drop-down list. If you do not enter an area code, Timbuktu Pro assumes that
you are making a local call and will not dial an area code.

4. Enterthe phone number in the Phone Number box. If you have dialed this
number before, you may also choose it from the drop-down list.

The complete phone number is displayed at the Dial line exactly as it will be
dialed. If you used Dialing Properties to disable call waiting or enable a dial-
ing prefix, the appropriate dialing sequence will be displayed preceding the
number. See your Windows or modem documentation for more information

about setting options in the Dialing Properties dialog box.

5. Choose Dial to dial the number and begin a Dial Direct connection. The
Modem Status window will appear to help you monitor your connection. For
more information about the Modem Status window, see the online Help.

6. Once the connection is established, you may launch any Timbuktu Pro ser-
vice normally, except Intercom. All services work in the same way as they do
over a TCP/IP connection.

TIMBUKTU PRO CONNECTION DOCUMENTS

Timbuktu Pro Connection Documents are desktop shortcuts that allow you to start
a Timbuktu Pro connection to a specific remote user by double-clicking a desktop
icon. The connection is reestablished with the saved parameters.

You may also right-click the Connection Document to display a shortcut menu.
Choose Timbuktu Pro » Any Service to establish a connection using the chosen
service.
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TO CREATE A NEW CONNECTION DOCUMENT
There are several ways to create a new Connection Document.

e Specify a remote computer on the Address Books, Recent Connections, or
TCP/IP tab in the main Timbuktu Pro window. Then click the Edit menu and
choose Create Shortcut on Desktop.

e Specify a remote computer in the Address Books, Recent Connections, or
TCP/IP tab. Then type CTRL+D.

e Right-click on your desktop and choose New » Timbuktu Pro Connection
Document. You will need to specify an address before you can use the new
Connection Document.

Once the shortcut is created, you can rename it by right-clicking on it. From the
shortcut menu, choose Rename. Do not change the .tmb extension.

If you wish to change the address or default service of one of your Connection
Documents, or if you created it without specifying a remote computer, you will
need to change its properties.

TO CHANGE THE PROPERTIES OF THE CONNECTION DOCUMENT

1. Right-click the Connection Document. From the shortcut menu, choose Prop-
erties. The Properties dialog box appears.

2. Click the Timbuktu Pro Properties tab.
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Control Goofball.tmb Properties

General | Timbukiu Pro Properties |Security Summary

Connectto remate computer using...

Address: |1n_?2.49.49

¥ Usess: |admin

Double-click connects to this address using:

Default Service: |CD ritral ﬂ

MNOTE: The S5H contact information has this syntas:
[usemarme [[@ssh_host] [ssh_pon]]

The default usernarme is your login name. The default
ssh_hostis the same as entered in the Address field.

[ OK l [ Cancel ] [ Apply ]

Enter or modify the remote computer address in the Address field.

To establish sessions with SSH, select the Use SSH checkbox and enter your
user name for the remote computer.

Modify the Default Service by choosing a service from the drop-down list.



CHAPTER 5: THE TIMBUKTU PRO SERVICES

This chapter introduces you to each of the many Timbuktu Pro services: Send, Ex-
change, Control, Observe, Notify, Chat, Intercom, Invite, and Skype. (The Control
and Observe services are collectively known as Remote Control.) Each Timbuktu
Pro service allows you to interact with remote computers in a different way; to-
gether, they help you make the most of your network.

SEND: SENDING FLASHNOTES AND FILES TO REMOTE COMPUTERS

Timbuktu Pro’s Send service can send messages similar to electronic mail, called
FlashNotes, to another computer. You can also attach files and folders to the mes-
sages and send them to other computers easily.

Timbuktu Pro temporarily stores the files you send in a specific folder on the re-
mote computer. Likewise, remote users can send files only to your files received
folder, which you specify on the Send tab in the Preferences dialog box.

Send does not allow remote users to see the folders on your computer. Once you
receive the files, you can save them to any directory you wish.

To SEND A FLASHNOTE TO A REMOTE COMPUTER

1. Select the remote computer or establish a Dial Direct connection. (See Chap-
ter 4, “Making a Timbuktu Pro Connection.”)

2. From the Services menu, choose Send. Or click the Send service button. The
FlashNote window is displayed. (Note that you may need to ask for permis-
sion or log in as a Registered User before the window opens.)

|70
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% FlashNote

To: | 10.36.36.21

Message: | Eric: Here are the files we discussed yesterday. Please let me
know if you'd like any changes. Thanks.

Files: (L1 C:\Business Plan
C:\Denver Presentation.ppt

Help Add Files... ‘ Cancel ‘ Send |

| No files attached.

3. Tosend a note, type a message in the upper panel.
To include files with your message, click the Add Files button.

You may also drag and drop files and folders from the desktop or from Win-
dows Explorer into the Files area in the FlashNote window.

5. Inthe Add Files to Send dialog box, locate and display the source folderin
the upper panel.

6. Select the files you want to add in the upper panel and click the Add button.
The files that you select in the upper panel appear in the lower panel. If you
wish to remove a file that you added, select the file in the lower panel and
click the Remove button.

Note: You may also drag and drop files and folders from the desktop or from
Windows Explorer into the lower panel of the Add Files to Send dialog box.

7. Click the Done button when you have finished selecting files.

8. Click the Send button in the FlashNote window to send the FlashNote and
files.

9. To stop a file transfer immediately, click the Cancel button. Timbuktu Pro
stops the file transfer, but the FlashNote is still sent to the remote computer.
In addition, stopping the file transfer does not affect files that have already
been transferred.

When you receive a FlashNote, you may wish to save the FlashNote and any at-
tached files.
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To SAVE FLASHNOTES AND FILES

1.

In the FlashNote window, click the Save Files button. The Save Files dialog
box appears.

Select the target drive and the destination folder.

In the lower panel, select the files or folders you wish to save in this location.
Click the Save button.

You may save each file and folder in a different location. When all of the files
have been saved, or when you click Done, the FlashNote window reappears.

If desired, print or save the FlashNote by clicking the Print Note or Save Note
button.

FlashNotes are saved with a default .rtf extension.

EXCHANGE: COPYING AND MOVING FILES BETWEEN COMPUTERS

With Timbuktu Pro’s Exchange service, you can copy and move files and folders in
both directions between your computer and another Timbuktu Pro computer. Ex-
change provides more flexibility than Send.

To COPY FILES AND FOLDERS BETWEEN COMPUTERS

1.

Select the remote computer or establish a Dial Direct connection. (See Chap-
ter 4, “Making a Timbuktu Pro Connection.”)

From the Services menu, choose Exchange. Or click the Exchange service but-
ton. The Exchange window is displayed. (Note that you may need to ask for
permission or log in as a Registered User before the window opens.)



Exchange: Copying and Moving Files Between Computers |73

'= Exchange Files with RAIN E@

File  View
Flyer

Local Drives: | 3 msI
[ TB2ADAUthULl.exe

TB2Computer.adm
TimbuktuPro.msi

REPARLING

Remote Drives: | 3 netOctopus Agent j gl l._§
(3 Admpiff NACpIModu.dIl nantsys.sys

[ Log MALODS.dIl [ nASpawme.exe

(1 Modules HAMsg.dil 1 NASPWN16.EXE
CharConversion.dll =] Nant.exe naswdiff.ini

[ peinstall.exe MANT Auth.dll

[ Execstub.exe 1 NANT Secc.exe
ModuleUtils.dll Mantspg5.dil
MACpIMod.dll Nantspnt.dil

The upper panel lists the drives, folders, and files on your computer. The
lower panel lists the same information for the remote computer.

Locate and display the source and destination folders in the Drives lists.
You can use the Create New Folder button create a new destination folder.

Drag the desired files or folders from the source panel to the desired folderin
the destination panel.

Timbuktu Pro begins to transfer the files immediately. The Exchange Files dia-
log box appears, indicating the progress of the file transfer.

While Timbuktu is transferring the files, you can

e Minimize or click outside the Exchange window to work on other tasks.

e  (lick Cancel to immediately cancel the transfer. The file being sent when
Cancelis clicked is not transferred, but any files that were previously sent
remain in the destination folder (unless you manually delete them).

When you have finished exchanging files, click the Close button.

You can also use the Exchange service while controlling or observing a Tim-
buktu Pro computer.
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REMOTE CONTROL: CONTROLLING OR OBSERVING A REMOTE
COMPUTER

You can use Timbuktu Pro to control or observe a remote computer. The desktop
of the remote computer is displayed in a window on your screen. The window is
updated as the other computer’s desktop changes.

While you are controlling another computer, you can perform any of the tasks that
you could perform locally, including opening applications and creating new files.
This means that a user with the Control privilege can remotely create, modify, or
delete files without restriction, and can erase data from the host computer. This
privilege, therefore, should be granted with caution.

While observing another computer, you can see the activity on its screen, but you
cannot control it. This privilege is useful for diagnosing problems on a remote
computer or giving a presentation.

If the remote computer’s screen resolution is higher than yours and you maximize
your Control or Observe window, the AutoScroll feature is enabled so that you can
view the entire remote desktop.

To CONTROL OR OBSERVE ANOTHER COMPUTER

1. Select the remote computer or establish a Dial Direct connection. (See Chap-
ter 4, “Making a Timbuktu Pro Connection.”)

2. From the Services menu, choose Control or Observe. Or click the Control or
Observe service button.

Timbuktu Pro displays the remote computer’s desktop in a screen-sharing
window. (Note that you may need to ask for permission or log in as a Regis-
tered User before the window opens.)

e Ifyou have chosen the Observe option, you will be able to observe the
screen only.

e Ifyou have chosen the Control option, you can use your mouse and key-
board to operate the remote computer.

e Ifthe user of the remote computer has enabled the Use Capture Frame
option in the Preferences dialog box, the screen-sharing window will be
blank until the remote user clicks the Play button in the Capture Frame.
(For more information about the Capture Frame, see “Enabling the
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Remote Control Capture Frame” on page 30 and “Using the Capture
Frame” on page 78.)

e (lick on a screen-sharing window to make it the active window. If you are
controlling more than one computer, only the active window will be
affected by your actions. To return to your own computer, click outside
the screen-sharing window.

3. During your session, use the screen-sharing window’s system menu to
change screen-sharing window settings. To open the system menu, click the
Control or Observe icon in the upper-left corner of the screen-sharing window.
(See “The Screen-Sharing System Menu” on page 76 for more information.)

4. To stop controlling or observing, open the system menu and choose Close.
Timbuktu Pro closes the window and ends the connection.

If the screen-sharing window doesn’t open, you may have one of the following
problems:

*  You have not been granted permission to use the Control or Observe service
on the remote computer.

e Timbuktu Pro is not running on the remote computer.

e Thereis a network firewall between the computers.

If the screen-sharing window appears, but remains blank, the user of the remote
computer may have enabled the Use Capture Frame option. Unless the remote
user is present at the computer and allows the screen-sharing session to pro-
ceed, you will not be able to view the remote computer.

If a remote user is controlling or observing your computer while Timbuktu Pro is
minimized, the regular Timbuktu Pro icon in the system tray on the taskbar is re-
placed with an icon that alternates between the regular Timbuktu Proicon and a
service icon that indicates you have a remote user controlling or observing your
computer.

Note: If you want to enable or disable the Control or Observe service on your com-
puter, you can do so in the Security dialog box. See Chapter 6, “Security,” for
information on granting services to remote users.

While controlling or observing a remote computer, you can start another Timbuktu
connection to the same computer. Open the screen-sharing window’s system
menu (click the Control or Observe icon in the upper-left corner of the screen-
sharing window) and choose another service.

Note: Timbuktu Pro does not support full-screen DOS sessions. Press ALT+ENTER
to switch the MS-DOS session from full-screen to windowed mode.
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THE SCREEN-SHARING SYSTEM MENU

The screen-sharing window’s system menu includes a number of options to con-
trol settings for the screen-sharing window.

To open the system menu, click the Control or Observe icon in the upper-left cor-
ner of the screen-sharing window.

e Choose Always On Top to force the screen sharing window to remain on top of
all other application windows.

e Choose Logical Keyboard to use logical keyboard mapping if the host and
guest computers use different keyboard types. For example, if the host com-
puter uses a Qwerty keyboard and the guest computer uses a Dvorak key-
board, pressing the Y key on the guest computer will have the same effect as
pressing the Y key on the host computer.

e Choose Show Scrollbars to display scroll bars in the screen sharing window.
(When the screen-sharing window is maximized, scroll bars will not appear,
even when this option is selected.)

e Choose Sync Lock States to match the CAPS LOCK, NUM LOCK, and SCROLL
LOCK settings on the host computer to the settings on the guest computer.
This matching occurs as soon as you press a key while the screen-sharing
window is in focus.

Or choose the Host Settings option to open a dialog box with many of the guest
computer screen-sharing options.

THE HOST SETTINGS DIALOG BOX

With the Host Settings dialog box, you can change your guest preferences on the
fly, during an active screen-sharing session.

To open the Host Settings dialog box, open the screen-sharing window’s system
menu and choose Host Settings. (The Host Settings option is available only when
the screen-sharing host is a Windows computer.)

Note: Changes you make in the Host Settings dialog box apply only to the active
screen-sharing session. They will not be applied to subsequent screen-sharing
sessions.
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Host Settings

[ Blank Screen Ok
[v' Disahle desktop wallpaper Cancel

[v" Disahle Active Desktop
Help

4l

[v Disahle animations
[v' Disahle full window drag

[v Disahle screen saver

Filter:

||_DSS-|BSS hd

e Select Blank Screen to activate secure screen blanking. Secure screen blank-
ingis a Timbuktu Pro security feature that prevents unauthorized viewing of a
computer’s screen while it is being controlled by a remote user. See “Secure
Screen Blanking” on page 30. (The Blank Screen option will be available only
if the host computer allows you to force the screen to blank.)

e Select Disable Desktop Wallpaper to remove the Windows wallpaper from the
remote computer’s desktop while you control or observe the computer.

e Select Disable Active Desktop to disable Active Desktop on the remote com-
puter while you control or observe the computer.

e Select Disable Animations to disable desktop animations on the remote com-
puter while you control or observe the computer.

e Select Disable Full Window Drag to disable full window drag (in which the
window’s contents are displayed while it is dragged) on the remote computer
while you control or observe the computer.

e Select Disable Screen Saver to prevent the screen saver from running on the
remote computer while you control or observe the computer.

e Select an option from the Filter drop-down list to force a color-depth reduc-
tion before screen-sharing data is sent from the host computer to your
computer.

During your remote-control session, Timbuktu Pro checks the Filter setting on
both the host and guest computer. The more restrictive (faster) setting is
used. (If the host computer is hosting multiple guest connections simulta-
neously, the most restrictive Filter setting is used for all sessions.)

Note: If these settings are not enabled on the host computer, but enabled on the
guest computer, the guest settings will be used during the screen-sharing ses-
sion. However, if these settings are enabled on the host computer, the guest
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computer cannot disable them. If the host computer is hosting multiple guest
connections simultaneously, the settings for all guest computers are “com-
bined,” and the same settings are used for each connection.

USING THE CAPTURE FRAME

When the Use Capture Frame option is enabled, the screen-sharing window on
the guest computer displays only the portion of the host computer’s desktop that
appears within the Capture Frame on the host computer.

USING THE CAPTURE FRAME AS A GUEST

To begin any outgoing Control or Observe session, launch the service normally.
The screen-sharing window will open on your desktop (you may need to log in as
a Registered User or ask for permission first).

If the Use Capture Frame option is enabled on the host computer, the screen-shar-
ing window will be blank until the user of the host computer clicks the Play button
in the Capture Frame. Once the session begins, the screen-sharing window will
display only the portion of the host computer’s desktop that appears inside the
Capture Frame. The user of the remote computer may move or resize the Capture
Frame at any time. You will be able to use the Control and Observe services nor-
mally, except you will not be able to move or resize the Capture Frame even if you
are controlling the remote computer.

If the Use Capture Frame option is not enabled on the host computer, the screen-
sharing session will proceed automatically.

USING THE CAPTURE FRAME AS A HOST

If the Use Capture Frame option is enabled on your computer and a remote user
begins an incoming Control or Observe session, the Capture Frame will appear on
your desktop. Click the Play button in the upper-left corner of the Capture Frame
to allow the Control or Observe session to proceed. (Until you click the Play but-
ton, the screen-sharing window on the remote computer is blank.)

During the screen-sharing session, only the portion of your desktop that appears
in the Capture Frame is displayed on the remote computer. You may increase or
decrease the size of the Capture Frame or move the Capture Frame around your
computer’s desktop. The remote user will not be able to move or resize the Cap-
ture Frame, even with the Control service.
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To close the incoming connection, close the Capture Frame.

If the Use Capture Frame option is not enabled on your computer, any incoming
screen-sharing sessions will proceed automatically, subject to the security con-
trols you have placed on your computer.

SENDING CTRL+ALT+DEL TO A REMOTE COMPUTER

If you’re connecting to a computer that is running a secure Windows operating
system, and need to log on, you’ll need to open the Logon Information dialog box.
It’s not possible to do this simply by pressing the CTRL+ALT+DEL keys on your
computer. You’ll need to follow the steps below.

To DISPLAY THE WINDOWS LOGON INFORMATION DIALOG BOX

1. Control the remote Windows computer.

2. Click the system-menu button (the Control or Observe icon in the upper-left
corner of the screen-sharing window) and choose Send Ctrl+Alt+Del to
Remote Computer.

The Logon Information dialog box is displayed on the remote computer,
allowing you to enter your user name and password.

You don’t have to log on to Windows to use Timbuktu Pro with a secure Windows
computer. You can exchange files with and send files to a remote computer when
the Logon Information dialog box is displayed. However, FlashNotes are not dis-
played on the Windows system until after you have logged on.

CONTROLLING A MACINTOSH COMPUTER

Controlling a Macintosh computer is usually identical to controlling a Windows
computer. However, their keyboards are slightly different. If you need to send a
Command (%) keystroke to the Macintosh, press the Window key on your Win-
dows computer.

When you control a Macintosh, the Map Ctrl-> Cmd option appears on the system
menu in the screen-sharing window. (To open the system menu, click the Control
or Observe icon in the upper-left corner of the screen-sharing window.) If you en-
able this option, pressing CTRL on your Windows keyboard will send the equiva-
lent of a Command keystroke to the Macintosh. If you disable this option,
pressing CTRL on your Windows keyboard will send CTRL to the Macintosh.
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NOTIFY: REQUESTING NOTIFICATION WHEN THE REMOTE USER IS
ACTIVE

Timbuktu Pro’s Notify service lets you leave a request to be notified when another
Timbuktu Pro computer becomes active. This is a useful way to find out when the
person you want to communicate with is available. You can then call or begin a
Chat or Intercom session with the user of the remote computer.

TO REQUEST NOTIFICATION OF ANOTHER USER’S PRESENCE

1. Select the remote computer or establish a Dial Direct connection. (See Chap-
ter 4, “Making a Timbuktu Pro Connection.”)

2. From the Services menu, choose Notify. Or click the Notify service button. The
Notify window is displayed. (Note that you may need to ask for permission or
log in as a Registered User before the window opens.)

P Notifying RAIN

Cancel

?/ Waiting for an answer...
e
Idle 00:00:01:40

Help

Last Active:
Wednesday, January 19 2005, 02:22 PM (Local Time)

“Waiting for an answer” appears near the top of the window. Below it are the
following fields:

¢ /dle Time tells you how much time has passed since the remote user has
used that computer.

e [astActive tells you the date and time the remote user last moved the
mouse or pressed a key. This field changes to Became Active the next
time the remote user moves the mouse or presses a key, and displays
the new date and time.

3.  While you’re waiting, you can work on tasks in other windows. You can mini-
mize the Notify window, but don’t close it.
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4. On the remote computer, the Request for Notification dialog box tells the
remote user that you are asking for notification.

Note: If the remote user selected Answer Automatically on the Notify tab in
the Preferences dialog box, the Request for Notification dialog box does not
appear. You will be notified immediately when the remote computer becomes
active.

! RAIN is asking to be notified...

? J RAIM is asking to be notified... Acknowledge
Address: 19.16.10.10
Wait  00:00:00:15 Ignore
Send ‘ Exchange ‘ Help
Control ‘ Observe ‘
Chat ‘ Intercom ‘

When the remote user clicks Acknowledge in the Request for Notification dia-
log box, the message in your Notify window changes to “Name is there.”

P Notifying RAIN

l! RATIM is there. oK
L ]

Help

Became Active:

Wednesday, January 19 2005, 02:27 PM (Local Time) . .
Notify Again

Chat

Intercom

The remote user also has the option of clicking the /gnore button. If the remote
user clicks the Ignore button when you ask for notification, the Notify window on
your computer will not change even when the remote user becomes active.

Once you have been notified of the remote user’s return, you can close the Notify
window and call the other user, or you can use any of the additional buttons that
are now displayed—Notify Again, Chat, or Intercom.

If the Notify window is acknowledged while you are away from your computer, the
remote user may no longer be at their computer by the time you get back. You can
start the notification process again by clicking the Notify Again button.
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CHAT: CHATTING WITH A REMOTE USER

The Chat service lets Timbuktu Pro users and their guests post messages to one
another interactively. For example, if you are already in the midst of a file transfer
session, a Chat session lets you discuss the file transfer with the other user.

TO CHAT WITH A REMOTE USER

1.

Select the remote computer or establish a Dial Direct connection. (See Chap-
ter 4, “Making a Timbuktu Pro Connection.”)

From the Services menu, choose Chat. Or click the Chat service button. The
Chat window is displayed. (Note that you may need to ask for permission or
log in as a Registered User before the window opens.)

© Chat with RAIN gg

< Flyer =: Hi, Eric. Did you get the files you sent?

I'm hoping to receive comments by

Disconnect ‘ Erint | Save ‘ Help ‘

Connected

Type your first message and press ENTER or click the Send button.

Your message is copied to the transcript panel in the upper part of the win-
dow and to the Chat window on the remote computer. Type more messages
immediately or wait for a reply from the other user.

The reply is displayed below your message in the transcript panel. You can
keep typing messages back and forth as long as you like.

When you’ve finished chatting, click the Disconnect button. When either
party disconnects, the session is ended, and the message at the bottom of
the window changes to Disconnected.
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7. After you have disconnected, you can print or save the chat-session details.

e (Click Printto print the chat-session details.
e Click Save to save the chat-session details to a rich text file (with an .rtf
extension).

8. Click the Close button in the upper-right corner to close the Chat window.

You can chat with more than one other user at the same time, but you will need to
open a separate Chat session with each participant. For this reason, you cannot
chat with multiple users over a Dial Direct connection.

INTERCOM: SPEAKING TO A REMOTE USER

The Intercom service lets you speak to another Timbuktu Pro through your com-
puter’s audio hardware.

TO SPEAK TO ANOTHER TIMBUKTU PRO USER

1. Select the remote computer. (See Chapter 4, “Making a Timbuktu Pro Con-
nection.”) Intercom is not available over Dial Direct connections.

2. From the Services menu, choose Intercom. Or click the Intercom service but-
ton. The Intercom window is displayed. (Note that you may need to ask for
permission or log in as a Registered User before the window opens.)
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© Intercom with RAIN D|E|B|
s 2

Speaker Volume: — )7 High
Talking Threshold: — )7 High

[T Mute Mike
[ Using Headphones or Handset (Full Duplex)

Sound Compression:

|None (ISDI/LAN Connection, 64kbs) ~|
Receiving: G5SM Compression
Network 100% Transmit
100% Receive
Status: Idle
Help ‘ Close ‘

Note: If the sound card on your computer or the remote computer is already
being used by another application, such as recording or playback, you won’t
be able to begin your Intercom session until you close the other application.

3. When the Intercom window is displayed, begin speaking to the remote user.

Note: The Intercom window does not automatically stay on top of the screen
when other application windows are run in the foreground.

4. When you’ve finished talking, click Close.

INVITE: INVITING A REMOTE USER TO ACCESS YOUR COMPUTER

The Invite service allows you to invite other users to access your computer. Once
you have specified a remote computer to receive your invitation, you can select
the type of invitation you want to extend and send it to the remote user. A window
opens on the remote computer, inviting the remote user to begin the Timbuktu
Pro session. The recipient will be able to connect to your computer using the ser-
vice you specify, or decline your invitation by closing the Invite window.
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To INVITE A REMOTE USER TO ACCESS YOUR COMPUTER

1.

Select the remote computer or establish a Dial Direct connection. (See Chap-
ter 4, “Making a Timbuktu Pro Connection.”)

From the Services menu, choose /nvite. Or click the /Invite service button. The
Invite window is displayed.

Invite §|

@ Invite RAIN to connect with service:

Send ‘ Exchange ‘
Control ‘ Observe ‘
Chat ‘ Intercom ‘

In the Invite window, click a service button to specify the service you wish to
invite the other user to access.

Depending on the remote computer’s settings, you may need to ask for per-
mission or log in as a Registered User before the Invite process continues.

The Invite window appears on the remote computer, indicating the service
you invited the remote user to use.

You have been invited

The user of RAIN in\fites you Start Session
to an exchange session.

Cancel
Do you wish to start this session?

The remote user may click Start Session to launch the Timbuktu Pro service or
Cancel to close the Invite window.

Note: On Macintosh computers, the service window opens automatically. The
Macintosh user may begin using the service or close the window to cancel it.

When the remote user accepts the invitation and the Timbuktu Pro service is
launched, the remote user's computer becomes the guest computer and the local
computer becomes the host computer. Normally, when you launch a Timbuktu Pro
service, your local computer is the guest computer.
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SKYPE: USING SKYPE WITH A REMOTE COMPUTER

The Skype service integrates Timbuktu Pro with the Skype application from Skype
Limited. It includes two subservices, Skype Call and Skype Chat. You can launch
these Skype services from within the Timbuktu Pro interface.

To OPEN A SKYPE CONNECTION TO A REMOTE COMPUTER

1. Select the remote computer or establish a Dial Direct connection. (See Chap-
ter 4, “Making a Timbuktu Pro Connection.”)

You can select the remote computer on any tab in the main Timbuktu Pro win-
dow except Dial Direct. Using the Skype Contacts tab is not required; there-
fore, you can connect with the Skype service even if you don’t know the
remote user’s Skype Name. However, the Skype services are supported only
if both computers are running the Skype application and a Skype-compatible
version of Timbuktu Pro.

2. From the Services menu, choose Skype Call or Skype Chat. Or click the Skype
service button to launch the Skype Call service.

The Skype window is displayed. (Note that you may need to ask for permis-
sion or log in as a Registered User before the window opens.)

e Ifyou initiated a Skype Call session, the main Skype window opens, dis-
playing your contacts. The Skype call is initiated.

e Ifyou initiated a Skype Chat session, the Chat window opens. Proceed
normally with your Skype Chat session.

3. When you’ve finished talking or chatting, close the Skype window.

In addition to Skype Call and Skype Chat, the Skype transport allows you to con-
nect to Timbuktu Pro computers that you may not have been able to reach before.
See “Using the Skype Contacts Tab to Find a Remote Computer” on page 54 for
more information.



CHAPTER 6: SECURITY

Timbuktu Pro offers multiple levels of security that help you restrict access to the
different Timbuktu Pro services on your computer. Remote Timbuktu Pro comput-
ers can connect to your computer as several kinds of remote users: Guest Users,
Registered Users, Ask For Permission Users (or temporary guests), and Windows
NT Users (Windows NT-based hosts and guests only). Each kind of user can be
granted different levels of access.

Timbuktu Pro will alert you when remote users access your computer. The Tim-
buktu Pro icon in the system tray on the taskbar alternates with a service icon in-
dicating the presence of a remote user. You can disconnect remote users at any
time.

The activity log keeps a record of all remote computers that access your com-
puter, along with the services used. Finally, you can use a Timbuktu Pro master
password to prevent a user with direct access to your computer from changing
any of your Security, Preferences, or LDAP settings.

TIMBUKTU PRO REMOTE USERS

Timbuktu Pro allows you to specify many different levels of remote-user access.
You can allow all users to access certain services, and limit other services to
password-authenticated users.

Guest User access is available to all remote Timbuktu Pro users. You do not have
to assign any services to Guest Users, or you can select specific Timbuktu Pro ser-
vices you wish to make available to them. A Guest User does not have to supply a
user name or password to access the services you have assigned to guests.

Guest Users are normally assigned a limited range of services because guest ac-
cess is open to anyone without authentication. Services such as Send and Notify
are often assigned to guests; services such as Control and Exchange are almost
never assigned to guests. By default, Guest Users are granted the Send and No-
tify services.

|87
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If you enable the Ask For Permission option, a guest who does not have permis-
sion to use a particular service can request permission to use that service on a
one-time-only basis. If a remote user attempts to connect to your computer using
a service he or she has not been granted, a dialog box will appear on your screen
giving the name of the remote computer and specifying the service the user
wishes to access. (You may also require individual Registered Users and Win-
dows NT Users to ask for permission after they are authenticated.) See “Ask for
Permission Access” on page 99.

The Admit Temporary Guest feature is similar to the Ask for Permission feature
and is provided for compatibility with earlier versions of Timbuktu Pro.

Registered Users must supply a user name and password to access your com-
puter. You can create a Timbuktu Pro account for as many Registered Users as
you wish, and assign each user a specific set of access privileges. A Registered
User can access the services you have assigned to the Registered User account
anytime Timbuktu Pro is running on your computer.

Registered User status on one computer does not give the user the ability to con-
nect to any other remote computer. Access to Timbuktu services is granted on a
computer-by-computer basis.

Windows NT Users are the users and user groups on your Windows network who
have been granted permission to use specific Timbuktu Pro services on your com-
puter. The Windows NT Users you create are similar to Registered Users, but—
because they have already been authenticated by logging in to the Windows
network—they do not need an additional password to access your computer.

Note: Privileges granted to Guest Users are automatically granted to Registered
Users and Windows NT Users. You cannot withhold a privilege from a Registered
User and Windows NT User if that privilege is granted to guests.

THE SECURITY DIALOG BoOXx

The Security dialog box controls the security configuration for your computer.
There are three tabs in the Security dialog box: Guests, Registered Users, and NT
Users. These tabs allow you to

e Specify which Timbuktu Pro Services will be available to Guest Users.
e Specify whether guests will be able to ask for permission to use services you
haven’t assigned them.
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e (reate, modify, and remove Registered User accounts.

e Set password restrictions for Registered User accounts.

e Assign privileges to Windows NT Users (including users of Windows 2000,
Windows XP Pro, and Windows 2003).

The following sections describe how you can use the Security dialog box to con-
figure Timbuktu Pro security.

If a master password is specified for your computer on the Master Password tab
in the Preferences dialog box, you’ll have to supply the master password to ac-
cess the Security dialog box. (See “Setting Up Your Master Password” on page
38.)

MANAGING TIMBUKTU PRO USERS

Before other computers can use Timbuktu Pro to connect to your computer, you
must assign privileges to Guest Users, Registered Users, or Windows NT Users.

ASSIGNING SERVICES TO GUEST USERS

A service assigned to Guest Users is available to anyone who connects to your
computer using Timbuktu Pro. Remember to exercise caution when granting a
service to Guest Users. A Guest User does not have to enter a password to use the
service, and you are not prompted to give permission before the session begins.
However, the Timbuktu Pro icon in the system tray will indicate that a user has
connected to your computer (see “Monitoring Remote Connections” on page
102).
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TO GRANT SERVICES TO ALL GUEST USERS

1. From the Setup menu, choose Security. The Security dialog box appears.

Security R|

Guests lRegistered Users] NT Users]

Check the services you wish to grant to Guests

v Send [ Exchange (Read) [v Skype
[ Control [ Exchange (Write)

[T Observe [ Exchange (Delete)

[ Chat [ Intercom

[v Notify [ Invite

[+ Guests may ask for permission to use unchecked services.

OK | Cancel Apply Help

2. Onthe Guests tab, select the services you wish to grant to all Guest Users.

Note: Granting the Skype service will allow Guest Users to open Skype con-
nections to your computer without knowing your Skype Name. If you do not
grant the Skype service, Guest Users will still be able to open Skype connec-
tions to your computer if your Skype Name is saved in their Skype Contacts.

3. Ifyou wish to let remote users ask for permission to use services you have
not assigned to Guest Users, select Guests May Ask For Permission to Use
Unchecked Services.

4. Click OK to save your changes and close the Security dialog box.

You can return to the Security dialog box at any time to change access privileges.
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DEFINING REGISTERED USERS

Registered Users must supply a user name and password to access your com-
puter. You can create Timbuktu Pro accounts for as many Registered Users as you
wish, and assign each user a specific set of access privileges. If desired, you can
require Registered Users to ask for permission after they have been authenti-
cated but before they can connect to your computer.

A Registered User can access the services you have assigned to the Registered
User account anytime Timbuktu Pro is running on your computer.

When you wish to grant a remote user permanent, password-protected access to
your computer, you will define a Registered User account.
To ADD A REGISTERED USER ACCOUNT

1. From the Setup menu, choose Security. The Security dialog box appears.
2. Click the Registered Users tab.

Security §|

Guests Registered Users lNT Usersl

samm Assign user's name and password...
spark
Hame: |sammy

Password: | e

Confirm |

Check the services to grant

[v |[v Exchange (Read)
[ Control [v Exchange (Write)

[ Observe v Exchange (Delete)

Add Registered User

[ Chat [ Intercom
[v [ Skype
Remove Registered User [ Invite kyp

0On Host Service Request:

Password Restrictions... o
[v  Ask For Host Permission

Default @ no (" yes

in|30 seconds

0K | Cancel ‘ Apply Help
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Click the Add Registered User button to create a Registered User called “New
User.”

In the Name text box, enter the user name the Registered User will use to
connect to your computer.

In the Password and Confirm text boxes, enter the password the Registered
User will use to connect to your computer. The password is case-sensitive.

You will not be able to close the Security dialog box until the text in the Pass-
word and Confirm text boxes matches exactly.

During the log-in procedure, the Registered User is free to change the pass-
word as long as the replacement password conforms to any password restric-
tions you have set. See “Setting Password Restrictions” on page 93.

In the Check the Services to Grant area, select the services you wish to grant
to this Registered User.

Services granted on the Guests tab are automatically granted to all Regis-
tered Users as well. For example, if you grant the Observe service to Guest
Users, you cannot deny this service to Registered Users. It will be dimmed in
the Registered Users tab.

Note: Granting the Skype service will allow the Registered User to open
Skype connections to your computer without knowing your Skype Name. If
you do not grant the Skype service, the Registered User will still be able to
open Skype connections to your computer if your Skype Name is saved in
their Skype Contacts.

Check the Ask for Host Permission box if you want the option to reject con-
nection attempts by this Registered User.

This allows you additional security beyond Registered User authentication.
After the Registered User’s user name and password are verified, the Ask for
Permission dialog box will appear on your screen. You can click OK to accept
the connection or Cancel to deny it.

Use a Default To radio button to automatically accept or reject the connection
when you are unable to answer the request within the time period specified
in the Seconds box.

If the Registered User attempts to access services you have granted to Guest
Users, you will not be given the opportunity to reject the connection. Guest
User access will be granted automatically.
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If the Registered User attempts to connect using a service you have not
granted in the Check Services to Grant area, the attempt will appear as an Ask
For Permission request. (See “Ask for Permission Access” on page 99.)

8. Click Password Restrictions to enforce password restrictions on the Regis-
tered Users connecting to your computer. For more information, see the fol-
lowing section, “Setting Password Restrictions.”

9. Click OKto save the new Registered User and close the Security dialog box.

SETTING PASSWORD RESTRICTIONS

When you click the Password Restrictions button on the Registered Users tab in
the Security dialog box, the Password Restrictions dialog box appears.

Password Restrictions g|

Enforce these password restrictions on users connecting to this computer

[v Passwords can't match the three previous passwords
[ Minimum number of characters in passwords |4

[v Mumber of days until password expires 30

Help oK | Cancel ‘

There are three options that may increase the security of the passwords used by
your Registered Users.

®  Passwords Can’t Match the Three Previous Passwords prevents the Regis-
tered User from reusing recently-used passwords.

e Minimum Number of Characters in Passwords requires Registered Users to
choose passwords of a minimum length, which may make them more diffi-
cult to guess.

e Number of Days Until Password Expires requires Registered Users to define
new passwords on a regular basis.

CHANGING OR REMOVING A REGISTERED USER ACCOUNT

If the privileges you have assigned a Registered User become inadequate for your
needs, or if the user no longer requires access to certain services, you may wish
to change the Registered User account privileges. If a Registered User no longer
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requires access to your computer, you may wish to remove the Registered User
account.

To CHANGE A REGISTERED USER ACCOUNT

1.
2.

3.

From the Setup menu, choose Security. The Security dialog box appears.
Click the Registered Users tab.

Select the desired Registered User from the list on the left side of the dialog
box.

To change the user’s name or password, select it and type the new value. If
you change the password, you will have to type it again in the Confirm field.

Select or clear the services you wish to grant or deny.
Click OK to save your changes and close the Security dialog box.

To REMOVE A REGISTERED USER ACCOUNT

From the Setup menu, choose Security. The Security dialog box appears.
Click the Registered Users tab.

Select the desired Registered User from the list on the left side of the dialog
box.

Click Remove Registered User to remove the Registered User.
Click OK to save your changes and close the Security dialog box.

DEFINING WINDOWS NT USERS

With the NT Users tab in the Security dialog box, you can assign Timbuktu Pro
privileges to Windows users and groups on Windows NT-based networks.

A Windows NT User account allows a Windows user (or user group or security
principal) to access Timbuktu Pro services on your computer. Because these us-
ers are authenticated when they log in to Windows, Timbuktu Pro does not re-
quire them to use an additional password when they connect to your computer. If
desired, you can require Windows NT Users to ask for permission after they have
been authenticated but before they can connect to your computer. The ask for
permission requirement can be enabled on a service-by-service basis, and you
can choose whether the default response (if you are not present) is to allow or
deny access.
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Note: The NT Users tab in the Security dialog box appears only when you have
privileges to read user/group settings from the Windows operating system.

ADDING A WINDOWS NT USER ACCOUNT

To allow Windows-authenticated users access to your computer, you will define a
Windows NT User account.

To ADD A WINDOWS NT USER ACCOUNT

1. From the Setup menu, choose Security. The Security dialog box appears.
2. Click the NT Users tab.

Security g‘

Guests] Registered Users NT Users ]

-Service permissions

OPS\drew

OPS\Admins [v Send ]Allowaccess L]
[¢ Control  |Ask(defaultis No) |
[v Observe |Ask(defaultisNo) v |
[¢ Chat [Ask (defauttis Yes) |
[v Motify ]Allow access L]
v Exchange ]Ask (defaultis No) _vJ
[v Intercom ]Ask (defaultis No) L]
[V Invite [Ask (defaultis Yes) ¥ |
[v Skype ]Allow access ;]

Add... Remove ‘ Apply default response to "Ask For Host

Permission" dialog after: 305 seconds.
Name(s) to add: (separated by semi-colons)

|

0K ‘ Cancel ‘ Apply | Help

3. Click the Add button. The Select Users or Groups dialog box appears.
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The Select Users or Groups dialog box is the standard dialog box, used
throughout Windows, in which you select a set of users or user groups. See
your Windows documentation for more information about this dialog box.

Note: You can select only existing Windows users, user groups, and security
principals in the Select Users or Groups dialog box. You cannot create new
Windows objects.

In the Select Users or Groups dialog box, make sure the appropriate Object
Type and Location are selected for the Windows user, user group, or security
principal you wish to add as a Windows NT User.

e (Click Object Types to select the Windows security object types for which
you are searching. You may select any or all of the available object types.

e (Click Locations to select the domain or Organizational Unit in which the
user, user group, or security principal resides.

e (lick Advanced to open a different version of the Select Users or Groups
dialog box, which contains additional search options. The Common Que-
ries tab in the Advanced search generates a list of matches, from which
you can select the desired users.

In the Enter the Object Names to Select text box, enter the name (or partial
name) of the Windows user, user group, or security principal that you wish to
add as a Windows NT User. Search for multiple objects by separating each
search string with a semicolon. Then click Check Names.

The full identifier for each resolved Windows object will appear underlined in
the Enter the Object Names to Select text box.

e If multiple matches are found for any object, the Multiple Names Found
dialog box will display the matches. Select the correct object and click
OK.

e Ifany object is not found, the Name Not Found dialog box will appear
and prompt you to change the search parameters for that object. Update
the search parameters and click OK.

When each Windows object you wish to add as a Windows NT User is
resolved in the Enter the Object Names to Select text box, click OK to close
the Select Users or Groups dialog box.

You will not be able to close the Select Users or Groups dialog box until all
objects in the Enter the Object Names to Select text box have been resolved.

Timbuktu Pro displays a dialog box asking whether you would like to grant
minimal access permissions to the new Windows NT User or users.
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Tb2Pro X

‘T/ Should the new user(s) be granted minimal access to all services?
)

If you select Yes, the new user(s) wil be given Ask For Permission
access to all services. If you select No, the new user(s) wil not be
given any access by default. Once added, user permissions can be
adjusted as desired.

Yes No Cancel

e  (lick Yes to grant the user all services on an Ask for Permission basis.
You can modify the service permissions later in this procedure.

e (lick No to grant the user no access. You will assign service permissions
later in this procedure.

8. Inthe Security dialog box, in the list of users, select a Windows user or user
group.
9. Inthe Service Permissions area, select the check boxes for the services you

wish to grant. For each service you grant, select an Ask for Permission option
from the drop-down list.

The Ask for Permission options allow you additional security beyond Win-
dows authentication. If you have selected Ask (default is Yes) or Ask (default
is No) for any service, and a Windows NT User attempts to begin a connection
using that service, the Ask for Permission dialog box will appear on your
screen after the Windows NT User’s identity is verified. You can click OK to
accept the connection or Cancel to deny it. Timbuktu Pro will automatically
accept or reject the connection when you are unable to answer the request
within the time period specified by the Apply Default Response option.

If the Windows NT User attempts to connect using a service you have not
granted, the attempt will appear to you as an Ask For Permission request.
(See “Ask for Permission Access” on page 99.)

Note: Granting the Skype service will allow the Windows NT User to open
Skype connections to your computer without knowing your Skype Name. If
you do not grant the Skype service, the Windows NT User will still be able to
open Skype connections to your computer if your Skype Name is saved in
their Skype Contacts.

10. Click OKto close the Security dialog box.
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CHANGING OR REMOVING A WINDOWS NT USER ACCOUNT

If the privileges you have assigned a Windows NT User become inadequate for
your needs, or if the user or group no longer requires access to certain services,
you may wish to change or delete the Windows NT User account privileges.

To moDIFY AWINDOWS NT USER ACCOUNT

1
2
3.
4

5.

From the Setup menu, choose Security. The Security dialog box appears.
Click the NT Users tab.
Select a Windows NT User from the user list.

Select or clear the check boxes for the services you wish to grant or deny, and
specify Ask for Permission options as needed.

Click OK to save and close the Security dialog box.

To DELETE A WINDOWS NT USER ACCOUNT

1
2
3.
4

From the Setup menu, choose Security. The Security dialog box appears.
Click the NT Users tab.

Select a Windows NT User from the user list.

Click Remove to remove the Windows NT User account.

Note: Clicking Remove does not delete the Windows user or group from the
network database. It only removes the Windows NT User account from your
list of Timbuktu Pro authorized users.

Click OK to save and close the Security dialog box.

ATTENDED ACCESS

For security reasons, you may not wish to assign some privileges to remote users.
When these users require one-time-only access to a certain service, they may
connect to your computer as Ask for Permission Users or as temporary guests.
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ASK FOR PERMISSION ACCESS

If a Guest User is asking for permission to use a service you have not granted to
guests, the Ask for Permission dialog box will appear on your screen. The same
dialog box will appear if you have enabled the Ask for Host Permission option for
a specific Registered User or Windows NT User. (See “Defining Registered Users”
on page 91 and “Defining Windows NT Users” on page 94.)

Ask For Permission

The following user is waiting for admittance:

RAIN

Address: 19.16.10.10 Cancel
Service: Control Help

Timeout and refuse in 16 seconds.

WARNING! You are about to let another user access your computer
via the above mentioned service.

Close any windows that contain confidential information before
allowing Control or Observe.

Exchange will allow the remote user to access the files on your
hard disk, as well as files on any network drives you are currently
logged into.

The Ask for Permission dialog box provides the name of the computer requesting
the connection and the service that the remote user wishes to use. Click OK'to ac-
cept the connection, or click Cancel to deny the remote user’s request.

Note: If you grant Ask for Permission access to a user requesting the Exchange
service, you automatically grant the user access to all Exchange subservices:
Exchange (Read), Exchange (Write) and Exchange (Delete).

ENABLING ASK FOR PERMISSION REQUESTS

If you enable Guests May Ask for Permission to Use Unchecked Services on the
Guests tab in the Security dialog box (see “Assigning Services to Guest Users” on
page 89), remote users can ask for permission to use services that have not been
assigned to Guest Users.

If a remote computer attempts to access a service that has not been assigned to
guests, a Log In dialog box will appear on the screen, asking whether the user
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would like to connect as a Registered User (by supplying a name and password)
or as an Ask for Permission user. If the user chooses Ask for Permission, you (the
host) are prompted to approve the connection before the remote user can
connect.

Note: You cannot require users to ask for permission to use the Notify service.

To ENABLE REQUESTS BY ASK FOR PERMISSION USERS

1. From the Setup menu, choose Security. The Security dialog box appears.

2. Click the Guests tab. If the service for which you wish to require Ask For Per-
mission access is selected in this tab, deselect it.

3. Ensure the Guests May Ask for Permission to Use Unchecked Services check-
box is selected.

4. Click OK to save your changes and close the Security dialog box.

DISABLING ASK FOR PERMISSION ACCESS

If you decide that a certain service—for example, Control or Exchange—should
not be available to any user at any time, you must remove that service from the
list of guest privileges and from the list of privileges for every user account. You
may also disable the Ask for Permission feature.

To REMOVE A SERVICE FROM ASK FOR PERMISSION ACCESS

1. From the Setup menu, choose Security. The Security dialog box appears.

2. Click the Guests tab. If the service you want to remove from access is
selected, deselect it. To prevent users from even asking for permission to use
the service, deselect Guests May Ask for Permission to Use Unchecked Ser-
vices. Keep in mind that deselecting the Ask for Permission option may lock
out services you want to keep available for Ask for Permission Users.

3. Click OKto save your changes and close the Security dialog box.

TEMPORARY GUEST ACCESS

The Admit Temporary Guest option allows you to grant temporary access to Tim-
buktu Pro users are who running older versions of Timbuktu Pro. Temporary
guests are similar to Ask for Permission Users, but older versions of Timbuktu Pro
are unable to request access. You must arrange the connection in advance.
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To ADMIT A TEMPORARY GUEST

1.

Arrange an appointment with the user that wants to connect to your
computer.

At the appointed time, click the Connections menu and choose Admit Tempo-
rary Guest. The Admit Temporary Guest dialog box appears.

Admit Temporary Guest

The following guest is waiting for admittance:

X
e
_ el |

Address: 19.16.10.10 Cancel

Service: Control

Temporary Guest Privileges

v [ Exchange (Read)
v Control [ Exchange (Write)
v Observe [ Exchange (Delete)
[~ chat [ Intercom

My TCP/IP Address: |18.16.10.11

WARNING! You are about to let another user access your computer
via services checked in the box above.

Close any windows that contain confidential information before
allowing Control or Observe.

If Exchange is checked, the remote user will be able to access the
files on your hard disk, as well as files on any network drives you
are currently logged into.

Select the services you wish to grant the temporary guest.

When the temporary guest connects to your PC, the guest computer’s Tim-
buktu name and network address are displayed under The Following Guest is
Waiting for Admittance, along with the access privilege the temporary guest
has requested.

Click OK to begin the attended access session.

You can always deny a session if the unexpected occurs. For example, if a
guest connects with a privilege you are not expecting—if the Control service
is requested instead of Observe—click Cancel to break the connection.
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MONITORING REMOTE CONNECTIONS

There are a number of ways to keep track of and control Timbuktu Pro connec-
tions to your computer. When a remote computer connects, the Timbuktu Pro
icon in the system tray on the taskbar alternates between the application icon
and a service icon that indicates the service being used. (For a list of icons, see
“Icon Legend” on page 111.) Right-click the Timbuktu Pro icon to display a list of
current users and the services they are using. You can disconnect any or all users
at any time.

In addition, the activity log tracks past connections, so you can check on previ-
ous users at any time.

DISCONNECTING ALL REMOTE USERS

If you wish to disconnect all remote users from your computer (for example, you
wish to shut down Timbuktu Pro), click the Connections menu and choose Dis-
connect All Users. Timbuktu Pro immediately terminates sessions with all the re-
mote users listed below this command.

DISCONNECTING A SPECIFIC REMOTE USER

If you wish to disconnect a specific remote user from your computer (for example,
the user is using a service you did not intend to grant), click the Connections
menu and choose the remote user from the remote user list below the Disconnect
All Users option. Timbuktu Pro immediately terminates the session with the se-
lected remote user.

KEEPING REMOTE USERS OuUT

You can prevent remote users from accessing your computer by removing all Reg-
istered User and Windows NT User accounts and removing all services from Guest
User access. More simply, you can exit and shut down Timbuktu Pro by clicking
the File menu and choosing Exit and Shut Down Timbuktu Pro. If you exit Tim-
buktu Pro without shutting down the application (by clicking the File menu and
choosing Exit) remote users will still be able to use Timbuktu Pro to connect to
your computer.
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CLEARING THE PREVIOUS USER LIST

The Previous User list consists of names of recent users who are no longer con-
nected to your computer. Those names appear on the Connections menu under
the Clear Previous User Log option, as well as in the system menu (right-click the
Timbuktu Pro icon in the system tray on the taskbar). Remove names from the
Previous User list by choosing Clear Previous User Log from the Connections
menu.

Open Connections

Disconnect All Users Admit Temporary Guest... Ctr+G

S Disconnect RAIN Activity Log...
Clear Previous User List Disconnect All Users
B! = Disconnect RAIN
1

Clear Previous User Log
Admit Temporary Guest... B!
About Timbuktu Pro... !

Exit and Shut Down Timbuktu Pro Tmbuktu Pro Scanner

Timbuktu Pro system menu Connections menu

The names that are listed below the Clear Previous User Log option are deleted.

USING LOG FILES

Timbuktu Pro supports a number of different logging features to allow you to
track and record the Timbuktu Pro activity on your computer. See the following
section, “Timbuktu Pro Logging.”

TIMBUKTU PRO LOGGING

Timbuktu Pro supports a number of different logging features to allow you to
track and record Timbuktu Pro activity.

e The Activity Log maintains a list of the all incoming and outgoing Timbuktu
Pro connections on your computer.
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e The Event Log file is a text document which records the same information
that Timbuktu Pro records in the Windows Application Event Log. The text file
format allows you to easily search the log for events you wish to review.

e The Windows Application Event Log also logs guest and host service events.

Timbuktu Pro also supports two different types of centralized logging for all the
Timbuktu Pro computers on your network:

e The Timbuktu Log Server allows you to copy information from your Timbuktu
Pro activity log or Event Log file to another Timbuktu Pro computer.

e The NT Event Log Server allows you to copy information about Timbuktu Pro
events from your Windows Application Event Log to the Application Event Log
on another Timbuktu Pro computer.

You may also now specify the maximum size for your log files, and you may spec-
ify that certain configuration changes are recorded in the log files.

To set up your logging options, use the Logging tab in the Preferences dialog box
(see page 42). See the following sections for more information about each type of
log.

THE ACTIVITY LOG

The activity log maintains a list of the all incoming and outgoing Timbuktu Pro
connections on your computer. The activity log is a useful record of Timbuktu Pro
activities. You can also use the activity log to diagnose problems you encounter
when using Timbuktu Pro.

Each line of the activity log contains a date, a time, and the activity that was car-
ried out—for example, the Timbuktu Pro application was launched. The activity
log also contains the Timbuktu Pro computer name and IP address of each re-
mote user that connects to your computer, records when the user connected, and
specifies which services the user accessed. For file transfers using the Send and
Exchange services, the file name and the local directory involved in the transfer
are logged on both computers. For Exchange file transfers, the guest computer
also logs the remote directory.

Finally, the activity log reports when Timbuktu Pro was loaded and shut down,
and when previous users were cleared from the Connections menu.

At times you may wish to save or print the activity log for your records.
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To VIEW AND SAVE THE ACTIVITY LOG

1. From the Connections menu, choose Activity Log. The activity log appears.

B Activity Log X

01/19/2005 3:02:14 PM Dial Direct Initiated SPRING -
01/19/2005 3:03:21 PM Ask For Permission - Control Admit  RAIN RAIN
01/19/2005 3:03:51 PM Ask For Permission - Control Deny RAIN RAIN
01/19/2005 3:07:36 PM Temp Guest Dialog Opened

01/19/2005 3:08:18 PM Temp Guest Deny

01/19/2005 4:13:52 PM Guest Invite Begin RAIN Spring 12.16.1.12
01/19/2005 4:14:03 PM Guest Invite End RAIN Spring 12.16.1.12
01/19/2005 4:14:19 PM Ask For Permission - Chat Admit  RAIN RAIN
01/19/2005 4:14:30 PM Ask For Permission - Chat Accent RAIN RAIN
01/19/2005 4:14:30 PM Host Chat Begin RAIN Spring 12.16.1.12
01/19/2005 4:39:03 PM Host Chat End RAIN Spring 12.16.1.12

Help Save As... ‘ Close |

2. Ifyou’d like to save a copy of the activity log, verify that your computer has at
least 32K of available disk space, then click Save As.

3. Inthe Save As dialog box, enter a name for the saved activity log, and select
a destination folder. The activity log is saved in .txt format.

In addition to saving a copy of the activity log, you may edit or print it at any time.

To EDIT OR PRINT THE ACTIVITY LOG

1. To edit or print the activity log, click Save As in the Activity Log window and
save the log as a text document. The text document can then be opened and
printed by a word processing application such as Notepad, or imported into
a spreadsheet or database document.

2. Click OK.

The activity log can preserve up to 32K of activity information before it begins to
discard its oldest records.



Using a Master Password | 106

THE EVENT LOG FILE

The Event Log file is a text document which records the same information that
Timbuktu Pro records in the Windows Application Event Log. The text file format
allows you to easily search the log for events you wish to review.

THE WINDOWS APPLICATION EVENT LOG

Timbuktu Pro logs guest and host service events to the Windows Application
Event Log.

To see these events in the Windows Application Event Log, open the Windows
Start menu. Choose Programs » Administrative Tools » Event Viewer and choose
the Application option.

USING A MASTER PASSWORD

In many situations it may be possible for multiple users to access your computer
directly by sitting at your workstation. To protect your Timbuktu Pro settings, you
can set a master password on the Master Password tab in the Preferences dialog
box. Your master password prevents unauthorized users from accessing any of
the options on the Setup menu, which is used to change Timbuktu Pro’s configu-
ration and security settings. When you use a master password, Timbuktu Pro will
not allow you to access the Security, Preferences, and LDAP Options dialog boxes
until you enter the correct password.

No one can bypass the master password. If you forget your master password, you
will need to re-install Timbuktu Pro.

See “Setting Up Your Master Password” on page 38 for details on how to set and
change your master password.



CHAPTER 7: TIMBUKTU PRO USER ASSISTANCE

Timbuktu Pro was designed to be as intuitive and easy-to-use as possible. This
manual should answer most of your questions. If you’re still having difficulty, you
can refer to the online Help for more comprehensive information. If you are still
unable to solve your problem after referring to all the documentation, you may
contact Netopia’s Technical Support.

GETTING HELP IN TIMBUKTU PRO

Timbuktu Pro’s comprehensive online Help provides a variety of ways to answer
your questions. It contains step-by-step instructions for all common procedures,
as well as troubleshooting hints, keyboard shortcuts, and a glossary.

You can navigate through the online Help using the Table of Contents, Index, and
hyperlinks between Help topics.

You may also wish to view the Timbuktu Pro Release Notes, which may contain
feature and troubleshooting information that was not available at the time this
document was created.

OPENING TIMBUKTU PRO’S ONLINE HELP

In the main Timbuktu Pro window, click the Help menu and choose Contents. Or
press F1 from anywhere within Timbuktu Pro for context-sensitive Help. If a Help
button is available in a window or dialog box, click it to display the online Help
topic associated with that area of the user interface.
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CONTACTING NETOPIA

If you require technical support, please browse Netopia’s Technical Notes and
Frequently Asked Questions, available 24 hours a day on our Web site at
http://www.netopia.com/support/.

Most common questions and problems are addressed there.

If you are unable to resolve your issue using our online technical support, please
use our online email form to send us a message. The form is at http://www.neto-
pia.com/support/contact_us.html.

Please provide the following information (for both the host and guest computers)
to assist us:

e Timbuktu Pro version and build number. Find this by selecting About Tim-
buktu Pro from the Help menu.

e Windows version, and any Service Packs installed.
e Error message or symptom.
e Steps to reproduce the error.
e Relevant system information:
. PC manufacturer and model
o CPU speed
. Amount of RAM installed
. Video card manufacturer and model
. Video device driver version
. Sound card manufacturer and model
. Modem manufacturer and connection speed (if relevant)
o Type of connection: DSL, cable, ISDN, modem, etc.

Netopia’s web site is at http://www.netopia.com/.

When you are prepared, contact Netopia Customer Service on the Web, or by mail
or fax.

Online Technical Support

Technical notes and Frequently Asked Questions which answer the most com-
monly asked questions and offer solutions for many common problems are avail-
able 24 hours a day on our Company Web site at

http://www.netopia.com/support/
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Mail

Netopia, Inc.

Customer Service

Marketplace Tower

6001 Shellmound Street, 4th Floor
Emeryville, CA 94608

USA

Fax

(510) 420-7609

OUuUTSIDE OF THE UNITED STATES AND CANADA

If you are not located in the United States or Canada, you can get service locally
by contacting your nearest Netopia reseller or distributor. For a worldwide list of
our distributors, see our Internet information resources at
http://www.netopia.com/partners/.



APPENDIX A: KEYBOARD SHORTCUTS AND SERVICE
ICONS

Timbuktu Pro has a number of keyboard shortcuts that allow you to quickly ac-
cess connection tabs, menu options, and dialog box options without using your
mouse.

TIMBUKTU PRO KEYBOARD SHORTCUTS

Controlling a Macintosh computer is usually identical to controlling a Windows
computer. However, their keyboards are slightly different. The following table
shows how keys are mapped across platforms.

Note: If you type a keyboard shortcut while you are controlling a remote computer
and the Control window is active, the shortcut is carried out on the remote com-

puter only.
Windows Keys Macintosh Keys
ALT Option
CTRL Control
CTRL+ALT+DEL Control+Option+Delete
Right-click (on mouse) 38 (Command)
Window 3 (Command)

When you control a Macintosh, the Map Ctrl-> Cmd option appears on the system
menu in the screen-sharing window. (To open the system menu, click the Control
or Observe icon in the upper-left corner of the screen-sharing window.) If you en-
able this option, pressing CTRL on your Windows keyboard will send the equiva-

lent of a Command keystroke to the Macintosh.
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ICON LEGEND

2 10:154M

Timbuktu Pro’s service icons allow you to quickly identify its many services.

Icon Legend

[111

The Timbuktu Pro icon is displayed in the system tray on the Windows taskbar
whenever Timbuktu Pro is running. When a remote user connects to your com-
puter, the standard Timbuktu Pro icon alternates with a service icon indicating the
service in use. If the service icon is in color, a remote user is connected. If the ser-
vice icon is gray, the connection is closed.

Timbuktu Pro Icons

User Icon Meaning
@ A remote user is using the Send service with your computer.
'E.D A remote user is using the Exchange service with your com-
] puter.

A remote user is using the Observe service with your com-
puter.

A remote user is using the Control service with your com-
puter.

A remote user is using the Chat service with your computer.

A remote user is using the Intercom service with your com-
puter.

A remote user is using the Notify service with your computer.

A remote user is using the Invite service with your computer.




INDEX

A

accelerating performance 28, 34
accepting incoming calls 39, 40
activity log 15, 104, 105
Activity Log option 105
Add Files to Send dialog box 71
adding files to FlashNotes 71
adding Windows NT Users 95
address books 16, 61, 64
Address Books tab 15, 59, 62
addresses

changing properties 64

saving to address books 63, 65
Admit Temporary Guest dialog box 101
Admit Temporary Guest option 101
admitting temporary guests 98
allowing Skype connections 40
Answer Automatically option (Notify Preferences)

81
Ask for Permission access

Log In dialog box 54

removing 100

requesting 54
Ask for Permission dialog box 99
Ask for Permission Users 87, 88, 98

allowing requests 9o

asking for permission 54

granting access 99

granting services 99

Log In dialog box 54

requesting access 99
asking for permission 54

Log In dialog box 54

attended access 98
authenticating
Registered Users 91
Windows NT Users 94
AutoScroll feature 74
autoscrolling 32

B
blanking the screen. See secure screen blanking

C

Capture Frame 30, 74, 78
enabling 30
starting session 78
using 78
changing
address book properties 64
Dial Direct preferences 40
general preferences 24
master password preferences 38
master passwords 38
Notify preferences 37
Observe/Control preferences 26
Registered User accounts 93, 98
Send preferences 35
Skype preferences 39
Chat service 82
printing and saving transcripts 83
Chat window 82
chatting with remote users 82
checking for remote users 102
checking the activity log 104
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Clear Previous User Log option 103
clearing the user list 103
communication protocols 7
compatibility between Timbuktu Pro versions 16
computer name 24
connecting to remote computers 49 to 69
Dial Direct connections 66
with Skype 54 to 56
Connection Documents 67
changing properties 68
creating 68
connection tabs
Address Books tab 15, 59
Dial Direct tab 66
LDAP tab 57
Recent Connections tab 15, 59, 63, 65
Skype Contacts tab 54 to 56
TCP/IP tab 51, 63, 65
connections
making 49
re-establishing 59
to a previously-used computer 59
using Dial Direct 66
using LDAP 57
using Skype 54
using TCP/IP 51
using the Desktop Shortcut extension menu
67
Connections menu
Activity Log option 105
Admit Temporary Guest option 101
clearing users 103
disconnecting remote users 102
Control service 74
Capture Frame 30, 78
changing preferences 26
controlling access to your computer 46
Dial Direct transport 40
Skype transport 39
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controlling remote computers 74
screen-sharing window 74
Copy dialog box 65
Copy to Address Book button 63, 65
copying files 72
Create New Folder button 73
Create Shortcut on Desktop option 65
creating
desktop shortcuts 65
folders on remote computers 73
new address books 65
CTRL+ALT+DEL, sending to remote computers 79

D

default installation location 19
default service
defined 15
Desktop Shortcut extension menu 67
desktop shortcuts, creating 65
Dial Direct
modem requirements 16
Dial Direct connections
modem requirements 16
Dial Direct feature 13, 66
accepting incoming calls 39, 40
changing preferences 40
establishing connections 66
Dial Direct tab (main Timbuktu Pro window) 66
enabling 66
Dial Direct tab (Preferences dialog box) 40
Dial Direct transport 7
dialog boxes. See individual dialog box names
disconnecting remote users 102
all users 102
disk space
protecting from usage 36
required for installation 16
displaying the Logon Information dialog box 79
DOS sessions, full-screen 75



E

enabling connection tabs
Dial Direct 40
Dial Direct tab 66
LDAP tab 57
Skype 39

Exchange service 72
creating new folders 73
subservices 99
Exchange window 72
exchanging files 72
Exit and Shut Down Timbuktu Pro option 22
Exit option 22
exiting and shutting down Timbuktu Pro 22
exiting Timbuktu Pro 22

F

file extensions
.tbk 62, 63, 64
.tmb 68
File menu
Exit and Shut Down Timbuktu Pro option 22
Exit option 22
Open Address Book option 63
files
adding to FlashNotes 71
copying between computers 72
saving from FlashNotes 72
sending 70
sending to another computer 71
files received folder 36, 70
FlashNote window 70
FlashNotes 70
adding files 71
display options 36
files received folder 36, 70
printing 72
saving 72
sending 70
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folders
creating on remote computers 73
See also files

G

general preferences, changing 24
General tab (Preferences dialog box) 24
getting Help 107
granting services to Guest Users 9o
Guest Users 87
defined 87
granting services to 90
guests
disconnecting 102
monitoring 102
temporary 100
Guests May Ask for Permission to Use Unchecked
Services option 100
Guests tab (Security dialog box) 90

H

hardware requirements 16
Help 107

icons 111
identifying your computer to remote users 24
ignoring Notify requests 81
incoming calls, accepting 39, 40
installation
default location 19
hardware requirements 16
pre-requisites 17
installing Timbuktu Pro 18
Intercom service 83
hardware requirements 16
Intercom window 83
Internet Locator 14, 26, 52
Invite service 84
Invite window 85



K

keeping remote users out 102
keyboard shortcuts 110

L

launching Timbuktu Pro as a service 25
LDAP option (Setup menu) 45
LDAP Options dialog box 44

Advanced tab 44

General tab 44

User’s Profile tab 45
LDAP server

finding remote computers 57

setting your options 44

user profile 45
LDAP tab 14, 57

enabling 57
LDAP tab (main Timbuktu Pro window) 57
location

default installation folder 19

files received folder 36, 70
Log In dialog box 54
logging on to a Windows 2000 computer 79
logging on to a Windows NT computer 79
Logging tab (Preferences dialog box) 42
Logon Information dialog box, displaying 79

M

main Timbuktu Pro window 16, 47
Address Books tab 59, 62
Dial Direct tab 66
enabling Dial Direct tab 66
enabling LDAP tab 57
LDAP tab 57
Recent Connections tab 59, 60, 63, 65
TCP/IPtab 63, 65
making a Timbuktu Pro connection 49 to 69
Master Password tab (Preferences dialog box)
38,39
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master passwords

changing 38

changing preferences 38

removing 39

setting 38

using 106
modem connections

changing preferences 40

Dial Direct connections 66
modem requirements (Dial Direct) 16
modifying. See changing
moving files between computers 72
MSI Installer 18

N

Network Neighborhood integration 15
New Address Book dialog box 65
new features in Timbuktu Pro 9
Notify service 80
acknowledging requests 81
answering automatically 81
changing preferences 37
ignoring requests 81
setting message to be displayed 38
Notify tab (Preferences dialog box) 37
Notify window 80
NT Users tab 94
failure to appear 95

0]

Observe service 74
Capture Frame 30, 78
changing preferences 26
Observe/Control tab (Preferences dialog box)
26, 31
observing remote computers 74
online Help 107
Open Address Book option 63
Open File dialog box 63
opening address books 63



P

password restrictions 93
Password Restrictions dialog box 93
Password Restrictions option 93
performance

accelerating 28, 34

protecting disk space 36
Preferences dialog box 23

Dial Direct tab 40

General tab 24

Logging tab 42

Master Password tab 38, 39

Notify tab 37

Observe/Control tab 26, 31

Send tab 35

Skype tab 39
Preferences option 24
preventing unauthorized access 106
previous users

activity log 104

clearing 103
printing

Chat sessions 83

FlashNotes 72

the activity log 105
protecting disk space 36
protocols for communication 7

R

Recent Connections tab 15, 59, 60, 63, 65
Registered Users 87, 91

authenticating 91

changing 93

defined 88

Log In dialog box 54
Registered Users tab (Security dialog box) 91
remote computers

accessing through the Network

Neighborhood 15

connecting to 49 to 69

finding with LDAP 57

re-establishing a connection 59

using Skype with 86
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remote connections, monitoring 102
Remote Control 74
remote users
checking for 102
controlling access 102
disconnecting 102
removing
master passwords 39
remote users 102
requesting access as an Ask for Permission User
54, 99
requesting notification 8o
requesting permission 54, 99
Log In dialog box 54
requests for permission
allowing 90, 100
granting 99
preventing 100
requirements
compatibility 16
hardware 16
software 16
restricting access to your computer 46
Dial Direct transport 40
Skype transport 39

S

saving chat sessions 83

saving files
files received folder 36
from FlashNotes 72

saving FlashNotes 72

screen blanking, secure. See secure screen
blanking

screen-sharing window 74
accelerating performance 28, 34
Capture Frame 30, 78
closing 75
scrolling automatically 32
system menu 75
troubleshooting 75

searching for remote computers 57

secure screen blanking 27 to 31



security 87
adding Windows NT Users 95
allowing Dial Direct access 40
allowing Skype access 39
Capture Frame 30, 78
checking for remote users 102
controlling access to your computer 46
disconnecting remote users 102
granting services to Guest Users 90
keeping remote users out 102
master passwords 38, 39, 106
password restrictions 93
Registered Users 91
Security dialog box
Guests tab 9o
NT Users tab 94, 95, 98
Registered Users tab 91
Select Users and Groups dialog box 95
Send service 70
changing preferences 35
files received folder 70
FlashNote display options 36
printing FlashNotes 72
saving FlashNotes 72
Send tab (Preferences dialog box) 35
sending files to another computer 71
sending messages and files 70
services 70to 86
Chat 82
Control 74
Exchange 72, 99
Intercom 83
Invite 84
Notify 8o
Observe 74
Send 70
setting Notify messages 38
Skype 86
setting password restrictions 93
setting up Timbuktu Pro 21

Index

Setup menu
LDAP option 45
Preferences option 24
Security option 90, 91, 98

shortcut menu 13

shortcuts, keyboard 110
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Shut Down Timbuktu Pro when Main Window
Closes option (Preferences dialog box) 25

shutting down Timbuktu Pro 22
Skype connections 54 to 56
allowing incoming 40
enabling 39
enabling incoming 40
preferences 39
software requirements 16
troubleshooting 56
Skype Contacts tab 54 to 56
Skype service 86
enabling 39
hardware requirements 16
preferences 39
software requirements 16
Skype tab (Preferences dialog box) 39
software requirements 16
speaking to remote users 83
Start Timbuktu Pro as a Service option
(Preferences dialog box) 24
starting Timbuktu Pro 21

startup, launching Timbuktu Pro as a service 25

system menu 75, 103

T

tabs. See connection tabs
.tbk file extension 62, 63, 64
TCP/IP address 48
TCP/IP tab 14, 51, 63, 65
making a new connection 51
temporary guests 87, 100
admitting 98, 101
Timbuktu computer name 24



Timbuktu Pro
exiting 22
features 9
activity log 15, 104
address books 16, 59
comprehensive multi-level security 15,
87
cross-platform connections 16
My Network Places integration 15
Network Neighborhood integration 15
Remote Control 11, 74
secure screen blanking 30
sending messages 15
service shortcuts 15, 67
installing 17, 18
introduction 6
keyboard shortcuts 110
launching as a service 25
main window 47
new features 9
security 87
services 70to 86
setting up 21
shutting down 22
startup 21
types of users 87
uninstalling 20
Timbuktu Pro Connection Documents 15, 67
changing properties 68
creating 68
Timbuktu Pro icons 111
Timbuktu Pro window 16, 47
Address Books tab 59, 62
Dial Direct tab 66
enabling Dial Direct tab 66
enabling LDAP tab 57
LDAP tab 57
Recent Connections tab 59, 60, 63, 65
TCP/IPtab 63, 65
Timbuktu Pro, new features 9
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.tmb file extension 68
transcripts of Chat sessions 83
transports 7
Dial Direct 8
Skype 7,39
TCP/IP 7
troubleshooting Skype connections 56

U

uninstalling Timbuktu Pro 20

Use Accelerated Capture option (Preferences
dialog box) 28, 34

User’s Profile tab (LDAP Options dialog box) 45

using the address books 61

w

windows
Activity Log window 105
Chat window 82
Exchange window 72
FlashNote window 70
Intercom window 83
Invite window 85
main Timbuktu Pro window 16
Notify window 80
screen-sharing 74
Windows 2000 Users. See Windows NT Users
Windows NT Event Log 106
Windows NT Users 87, 88
adding 95
authenticating 94
changing 98
defined 88
defining 94
Windows NT/Windows 2000
logging on 79
sending CTRL+ALT+DEL 79
Windows NT/Windows 2000 Logon Information
dialog box, displaying 79
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